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1 Introduction 

1.1 Introducing the Integris Lesson Attendance Module 

The Integris Lesson Attendance module offers schools an effective, flexible and timesaving facility 
for recording attendance and for analysing and reporting on attendance figures.   
 
This module is fully integrated with the suite of Integris education management software.  You can 
move between modules within Integris to view different aspects of your school management system.  
Your core school data is also used throughout the system so you do not have to re-enter key 
information in the individual modules.  For example in Lesson Attendance you have access to 
student and staff details, and school diary information. 
 

1.1.1 Key Benefits 

Use of the Lesson Attendance module contributes to school effectiveness in the following ways: 

 It helps teachers and managers to carry out their responsibilities. 

 It reduces workloads for busy teaching and administrative staff. 

 Data entry via the keyboard or mouse is simple and straightforward. 

 Late arrivals can be entered via the Lates window and attendance updated automatically. This 
function also prints Late Slips for students to give to teachers. 

 Absences can be entered via Speed Entry and attendance updated automatically with “present” 
marks for the remaining students. 

 Future absences can be entered for absences known in advance. 

 It avoids the need for time-consuming manual statistical calculations.  A range of standard reports 
and analyses is included with the system. 

 It saves time in the preparation of letters, attendance reports etc. 
 

1.1.2 Key Features 

Lesson Attendance includes the following key features: 

 It is simple to set up and run. 

 It supports all aspects of managing attendance data within one simple easy-to-use interface.  

 It includes a choice of data entry methods. These include data entry using either the mouse 
and/or keyboard. 

 It includes a facility for managing multiple absence tracking and automatically processing follow-
up letters.  

 It includes a wide range of standard reports and analyses. 

 It includes the ability to transfer report information to other software applications for inclusion in 
letters, reports etc. 

 The individuals using it can configure almost all aspects of the software. 

 It has seamless links with other modules in Integris, avoiding the need for any re-entering of 
student data. 
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1.1.3 How to Use this Manual 

The Lesson Attendance Manual should be used as a supplement to your existing Administration 
Manager Manual.   
 
Lesson Attendance is available in a variety of modes, dependent on country of usage etc. and not 
all functions are available to all users, or may appear differently to different users.  Therefore some 
screen shots in this manual may not be exactly the same as will appear on your installation. 
 
In addition, some terminology will vary from country to country.  Notably some countries use the term 
‘Form’ whereas others use ‘Class’.    
 
This manual describes how to manage lesson attendance data and includes the following main 
sections: 
 

Section 1 Introduction 

Section 2 
Getting Started – prerequisites to using Lesson Attendance; logging on;  closing 
Integris; backing up data. 

Section 3 
Setting up a New Attendance Year – covers the steps to follow in setting up an 
attendance year. 

Section 4 
Creating Daily Records – explains the process for creating attendance Daily 
Records 

Section 5 
Recording Attendance Data – outlines data entry methods for Lates, Speed Entry, 
Day View, Week View and Registration. 

Section 6 
 
Absences – outline Absences functionality including Absence Follow Up, Future 
Absences and Student View  

Section 7 Reports – Outlines Lesson Attendance Reports available 

Section 8 
Parameters – attendance codes, setting up the software for the school’s 
attendance year, create Daily Records function. 

Section 9 Behaviour Module - Related Functionality 

Section 10 
Recording Students’ Change of Status – including changes of part-time status, roll 
status and the deletion of records. 

Section 11 Miscellaneous Functionality – Outlines access to toolbar and multi user handling 

 
Refer to the Administration Manager Manual for information on managing the Integris system and 
for setting up and maintaining school, staff and student data. 
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1.1.4 Keyboard Shortcuts Used in Lesson Attendance 

Throughout Lesson Attendance you will find buttons with shortcuts. These shortcuts are provided to 
enable users to perform functions quickly, using the keyboard. Where you see one of the following 
buttons, shortcuts are provided.  

Examples 

Button Keyboard 
Shortcuts 

 
<Alt> + <O> 

 
<Alt> + <X> 

 
<Alt> + <D> 

 
<Alt> + <C> 

 
 



 
 
 
  

Lesson Attendance Manual 
 

Getting Started 

2 

 

            Lesson Attendance Manual 



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 2-2  

© 2020 Civica Education Pty Ltd  

 

2 Getting Started 
Before you can log on to the system for the first time you must: 
 

 Install and set up Integris Administration module, including your school, staff and student 
information as well as form descriptions. Version 2.42 of Lesson Attendance requires Integris 
v.6.82.01 or above of the Administration module to operate correctly. 

 Install the Lesson Attendance module and ensure that it is added to the data file with which you 
wish to work.  

 

2.1 Prerequisites for using Lesson Attendance 

 
Before you can start entering attendance information you must: 
 

 Set up the school diary in School Details under the General Tab.  This is done before the 
beginning of each academic year. For more information see the Administration Manager Manual. 

 Set up the attendance year in Lesson Attendance > Parameters.  This must also be done at the 
beginning of each academic year. For more information see Section 3 of this Manual. 

 Set up the timetable in Timetable Module, if it is used by your school. For more information see 
the Timetable Module Manual. 

 Create the current day’s records.  This must be done every day. It is recommended that this is 
done daily so student data will be current. For more information see Section 4 of this Manual. 

 
 

2.1.1 Logging on to Integris 

 Click on the Integris icon on the desktop.  

 The user login dialog box is displayed. 
 

 
 

 In the User Name field enter your user name. 

 Press the Tab key. 

 In the Password field enter your password. 

 Click Login or press <Enter>.  You will then be allowed access to the system. 

Note: the user ID and password used in this section are the default settings. To ensure the 
security of your system it is advisable that these be changed as soon as possible.  

See the Administration Manager Manual for details about how to change the user name and 
password. 
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2.1.2 Locking the Software on your Computer 

The software contains a function that enables users to lock out other users while away from the 
computer.  

 To lock the software click on File > Lock Terminal or use the shortcut of <Ctrl>+L.   

 
 

 To unlock it click Unlock. 

 
 

 Enter your password.  

 
 

 Click OK. 
 

2.1.3 Accessing Lesson Attendance from Integris 

 Log on to Integris in the usual way. 

 Click on Lesson Attendance in the sidebar.  The functions within Lesson Attendance are 
displayed on the sidebar. 

 

Note: If you cannot see the Lesson Attendance sidebar, contact your Support Centre 
regarding installation of this module. 
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2.2 The Lesson Attendance Sidebar 

The Lesson Attendance Sidebar provides the following options. 
 

 

          

 
Speed Entry – click on this icon to open the Speed Entry 
window.  N.B. If this icon does not show on the sidebar then 
this functionality is available via the Absences Menu 
 
Registration – click on this icon to open the Registration 
window.  This enables rapid selection of teaching set, date 
and correct period for on-line registration. 
 
Day View – click here to open the Day View window for 
viewing/entering attendance codes for a selected day.  

Note: the Day View icon will display as a ‘sun’ symbol 
for some schools, depending on the other modules 
used. 

Week View - clicking here will open the Week View window 
for viewing/entering attendance codes for a selected week. 
 
Absences – provides access to the Absence Follow Up, 
Future Absences, Speed Entry, Student View and other 
functions. 
 
Reports – access to the Lesson Attendance reports, as 
described in the separate Reports manual, is available 
through this icon. 
 
Parameters – this icon is used to access the various Lesson 
Attendance Parameters and Utilities. 

 
Closing the System Safely 

 Click on the File menu and select Exit. 

 You are asked whether you are sure you wish to exit.  
 

 
 

 Click Yes to continue.  Your data file is closed down safely and you are returned to your 
desktop. 

 Shut down your computer in the usual way. 
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2.3 Backing up Data Files 

It is crucial to maintain regular backups of your data.  If you fail to do this and you have a problem 
on your computer, you could lose valuable information.  
 
Should you require additional support with this function please refer to the back page of 
this manual for contact details. 
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3 Setting up a New Attendance Year  
The Create New Year function deletes all attendance records for the year being created and sets 
up files for a new attendance year. It does not delete data for other years.  It enables schools to set 
up timetable cycles, a period availability structure and set defaults. 
 
The main steps in creating a new attendance year are listed sequentially: 
 

 Ensure you have archived the previous year’s attendance data. (Note: This does not apply to 
DET WA schools) 

 Set up the new academic year in Admin > School Details, if it has not already been set up as 
part of the Administration Year End process. Enter holidays and any other days (e.g. 
professional development days) on which the school will be closed. Do not close the school for 
regular activities such as school assemblies. Enter those activities in School Details > School 
Activity section. Days such as holidays and professional development days must be set 
up prior to the date on which they occur and prior to daily records being created so that 
they are taken into account in the Lesson Attendance module. 

 Check the attendance codes specified are the correct attendance codes. See section 5.3.3 for 
details on attendance codes. 

 Define the new attendance year. 

 Set up timetable cycles. 

 Set up a period availability structure. 

 Set defaults. 

 Create daily records up to and including the current date. 
 

3.1 Setting up the New Year in School Details 

The New Year must be set up in the School Details window before the Attendance Year is created.  
 
See the Administration Manager Manual for more information on setting up the New Year in School 
Details. 
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3.2 Creating a New Attendance Year 

Lesson Attendance > Parameters >Create New Attendance Year 

The following conditions and assumptions are made in the Create New Lesson Attendance Year 
function: 
 
1. The school must be assumed to be normally open for the same days each week. 
2. The start of the attendance year may be up to a week before the start of the academic year. 
 
Make sure you have set up the school diary, entering all known professional development days, 
‘closed’ days, holidays, etc. 

Note: As part of the process of setting up the Attendance Year, you will set up period 
availability structures. If you wish to be able to display a form/teaching set of students as a 
group in Day View, all students in the form/teaching set will need to have the same period 
structure. Should you have students with different period structures in one form/teaching set 
their data can only be viewed/updated individually. 

Alternatively, split students into different forms/teaching sets (sub groups) to enable viewing 
by forms/teaching sets. 

 
When you are ready to create the new attendance year: 

 In Lesson Attendance sidebar > Parameters, double click on Create New Attendance Year.

 
 Read the text in the New Lesson Attendance Year window. 
 

 
 

 Click the Proceed button when you are sure you have met the prerequisites for creating the new 
attendance year. The New Attendance Year window opens. 
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FTE Warning Report 

An FTE warning check runs if either 
1. K students (and not P) are included in the current LA structure 
2. P students (and not K) are included in the current LA structure 
3. Both K and P students are included 

 
The FTE of the all of the students on the current roll is checked against the expected value for their 
year group. 
 
The expected FTE for a student in each year is as follows: 
 

Lesson Year Group Expected FTE 

Year group K FTE < 1.0 

All other Year Groups FTE = 1.0 

If all students on the current roll have the expected FTE value based on their Year Group then the 
Create New Year process will proceed as per the current process. 
 
Where neither Year Group K or P are defined as Year Groups using Lesson Attendance then the 
check on Student FTE will not be run and the Create New Year process will proceed as per the 
current process. This includes Secondary Schools. 
 
If at least one student is found on the current roll whose FTE value does not match the expected 
value in the table above, then a warning report is generated as shown below on the next page. 
 
The warning report orders students by surname and displays the following: 
 

 Student Name 

 Year Group 

 Form 

 FTE 

 Expected FTE 
 
The report will appear as a screen report, without the user being presented with the Report 
Destination window. The user can print the report to printer via the printer icon at the top left of the 
screen report if required. 
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 If student’s FTE needs to be corrected, click Yes 

 If student FTE values are correct click No 
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At the point of creation of a New Attendance Year in version 2.45 onwards, a new Attendance Code 
will be added to Codes List with letter “Y” 

 
The records will contain the following values: 

 Code letter = “Y” 

 Code Type = “Not counted in Attendance” 

 Code Description = “Enforced Closure” 

 Resolved Status = yes 
 
Before adding the Code, a check is made on the current codes to ensure that no “Y” code is already 
in place. 
 
It there is, a message will appear saying: 
 
“Lesson Attendance is attempting to add the new “Y” code (Enforced Closure”). Your system already 
contains a code with that label. Please contact you Support provider.” 
 

 
 
 

 Select the Year from the New Year field drop-down list.  

 Enter the date of the start of the attendance year in the Start of Attendance Year field. In some 
circumstances the start of the academic year will be the same as the start of the attendance year.  
Where attendance is not recorded from the beginning of the academic year these dates may 
differ (e.g. when Lesson Attendance is first implemented the school may be half way through the 
academic year). To change the date, highlight it and then enter the correct date or use the Select 
Date button to select the date. See Section 5.3.1 for more information on entering dates. 

 Press OK to proceed.  If the date entered is not a Monday or is more than one week before the 
start of the academic year the system displays a warning to this effect.  
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 Press Yes to proceed or No to go back to the New Attendance Year window and set the 
attendance date to match the academic year date.  

Note: It is strongly recommended that the start date of the attendance year is the Monday of 
the first week of the school year, even if the students actually commence the day after the 
Monday of that week. If students actually start on a Wednesday, the Monday and Tuesday 
should already have been marked as ‘Closed’ or ‘Holiday’ in the School Diary, so the 
attendance year can start on the Monday of that week. 

 

 If you have already set up an Attendance Year and you are editing it, you will be warned that 
the year has already been set up. You will be asked if you wish to retain settings. Press Yes to 
retain the settings or No to create new settings. 

 

 
 

 If there is attendance data in the year being setting up, a warning message will be generated 
that proceeding will delete all student attendance data for that attendance year. 

 

 
 

 Press Yes to proceed (or No to retain present attendance year and data). 

 The next step is to set up timetable cycles for attendance. 
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3.3 Setting up Timetable Cycles 

Lesson Attendance > Parameters > Timetable Cycle Start Dates 

The Timetables Cycles for Attendance window is shown below. It is displayed as part of the Create 
New Attendance Year function, and is also accessible through Parameters>Timetable Cycle Start 
Dates.  
 

 
 
This window enables users to: 
 
1. Define the days of the week when the school is open (where a school operates a timetable other 
than a standard five-day, Monday – Friday cycle). 
2. Define the number of days in the attendance cycle, when setting up a new attendance year. 
3. Set the start dates for each cycle in the school year. 

Note: It is possible to edit the descriptions of cycles. See section 3.3.1 for details on editing 
the field. 

Where a school uses a standard five-day cycle, the week numbers are initially derived from the 
school calendar. 
 

 The checkboxes next to the days of the week indicate the days the school is open. 
 

 
 

 Click on the Edit Cycle Days button  if you need to edit the cycle days.  
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 Enter the number of days in the school’s timetable cycle and mark the radio boxes next to the 
days of the week to indicate the days the school is open. 

Note: No adjustments will be made where a day in a cycle is marked as a Closed, Holiday or 
Inset (Professional Development). For example if day 4 in a cycle falls on a public holiday, 
the following day will be day 5 rather than day 4.  The user will have to enter all the dates 
manually. 

 Press Save  or <Enter>to save changes. 

 The cycle displayed in the Timetable Cycles for Attendance window reflects the weeks set up in 
the academic year, and also the start date for the attendance year as described in Section 3.2. 

Important: (for TIME and TIMETABLE users) 
 Where the Timetable module is used to define the student’s timetable, 
then the timetable module will also be used to manage the lesson data 
linked to the timetable.  Where a school adopts a non-standard week 
pattern, then this will need to be specified in the Timetable module.  

Refer to your Timetable manual for further details.  

3.3.1 Editing week/cycle descriptions  

 
The descriptions of each week/cycle may be edited so the data displays more meaningfully when 
using the software.  
 
To edit a description: 

 In Parameters > Timetable Cycle Start Dates > Timetable Cycles for Attendance window, click 

on the Edit button.    

 Highlight the description and then enter the new description.  
 
Examples: 

1. Where a week/cycle falls in the holidays, you may choose to describe the week/cycle as 
“Holiday”.  
2. Weeks can be renamed to include terms, e.g. Term 1, Week 2.  See screen shot below. 
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 Click Save to save the changes. 
 

 
 

3.3.2 Changing the cycle start dates 

The start dates of cycles may be changed as long as they are dates in the future.  

 Click on the Edit button.  
 

 
 

 Click on the edit pencil icon beside the start date.  

 Edit the date as required. If you edit a start date of a cycle it will alter the start dates of all 
subsequent cycles, so you may then need to edit later cycle start dates. In the above example 
the start date of Cycle Number 21 was edited, which affected subsequent cycles. 

 

3.3.3 Adding a new week/cycle 

Users may add a week/cycle to the attendance year. This is unlikely to be necessary as the 
attendance year will normally have been set up for the entire year. 
 
Should you need to add a week/cycle: 

 Click on the Add New Week/Cycle button.  

 The new week/cycle will be added after the last week/cycle. 
 

3.3.4 Deleting a week/cycle 

Change 
descriptions 
as required. 
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Weeks/cycles may be deleted if they have not already been used in the attendance year. 
 
To delete the last week/cycle: 

 Click on the Delete Last Week/Cycle button.  

 You will be asked to confirm that you want to delete the last cycle in the list. 
 

 
 

 Click Yes. 

 Click Save to save changes. 

 Click Next to go to the Period Availability Structure window. 

3.4 Setting up the Period Availability Structure 

Lesson Attendance > Parameters > Period Availability Structure 

The next step in creating an attendance year is to define the period availability structure/s within 
the school that will be used by Lesson Attendance. More than one period availability structure may 
be set up.  Once these have been set up each Year Group can be allocated a period availability 
structure.  
 
Example: In a district high school you may have three period availability structures 
1. Period attendance for secondary students; 
2. AM/PM attendance for primary students; and 
3. AM attendance for kindergarten students. 

Important: (for TIME & TIMETABLE Users) 
You will not have to set up Period Availability Structures within Lesson 

Attendance as these will be specified with the Timetabling module. 

The Period Structure for Lesson Attendance window displays the structure for a primary school. 
This standard period structure cannot be edited. 
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Each line indicates the day number in the week/cycle and the day description.  
It also displays the periods to be used in Lesson Attendance. The periods are allocated a type: AM 
Home, AM Teaching, Unavailable, Break, PM Home or PM Teaching. The key for the codes is 
displayed at the bottom of the window: 
 

Code Description 

H Home/care group period in the morning 

T Teaching period in the morning 

U Period when the student is not required to be in class (could be lunch 
period in school with a staggered lunch system) 

B Break period (e.g. Lunch Period,  when the student is not expected to 
have an attendance mark) 

h Home/care group period in the afternoon 

t Teaching period in the afternoon 

 
The use of lower case ‘h’ and ‘t’ is important where there is a need for the school to report on an 
am/pm basis. 
 

3.4.1 Creating a new period availability structure 

To add a new period availability structure: 

 Click on the Add New Structure button.  This opens the Create New Period Availability 
Structure window, which will speed the process of setting up a structure.  

Print 
Structure 
button 

Add New 
Structure 
button 

Edit 
Structure 
button 

Delete Period 
Structure 
button 



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 3-13  

© 2020 Civica Education Pty Ltd  

 

Note: If you prefer to enter each step of the structure manually click the Create Blank 

button.  

 Read the text in the window. It explains the assumptions made i.e. 
Home/registration periods are at the start of a session (AM/PM). 
Lunch periods occur between the morning and afternoon periods. 
All days in the structure are the same. 
 

 
 
If the assumptions do not apply, you can either use the wizard and then adjust the settings, or 

create structures from scratch using the  button. 
 

 Enter the name of the new period structure e.g. ‘Secondary’. 

 Click the Include a Morning Home/Registration Period check box to include a Home period in 
the structure in the morning. Leave it blank if there will be no Home Room in the morning. 

 Enter the number of teaching periods that occur in the morning. 

 Click the Include an Afternoon Home/Registration Period check box to include a Home period 
in the structure in the afternoon. Leave it blank if there will be no Home Room in the afternoon. 
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 Enter the number of afternoon teaching periods. 

 If you wish to show lunch as a non-teaching period in the attendance windows, check the Show 
Lunch as a Non-teaching period check box. This will not affect attendance data – it is used to 
make data entry and viewing data clearer for the user. 

 Click OK when you have entered the data. You will be asked to confirm that you wish to create 
the period availability structure.  

 Click Yes. 
 

 
 
The new structure is displayed. 
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If the structure meets your requirements, press Save to continue. If you wish to edit the structure, 
adding breaks and making other changes, follow the steps in section 3.4.2. 

The ‘Edit’ and ‘Delete’ period availability structure, as described below 
are only available during the initial process of setting up the attendance 

year. Once the attendance year structure has been saved, existing 
period availability structures cannot be edited or deleted and these 

buttons will be greyed out. 

3.4.2 Editing a period availability structure 

 

 Click on Edit Structure. 
 
To change a period structure, begin with changes to Day 1 of the cycle. This will enable you to 
copy the new structure for the remaining days in the cycle if they have the same structure as the 
first day. 

 Highlight a code in a cell that needs to be changed.  

 Enter the new code in the cell. Continue to make changes for the first day in the cycle. See the 
following screen shot that shows the addition of a morning break in the structure. 
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To copy the first day’s structure for the other days 

 Click the Fill Structure Down button.  

 Click Yes to confirm saving down the data. 
 

 
 
All days in the cycle will now have the same structure. 
 

 
 

 To set up different period availability structures for some of the days, simply edit the structure 
for those days as required. 

 Click Save to save the structures. 
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 Click the Next button to continue setting up the Attendance Year. See section 3.4.4. 
 
To set up a period availability structure for a year group with either AM or PM attendance only (e.g. 
for a year group that attends only in the mornings) in the Create New Period availability Structure 
window: 
 

 Enter ‘1’ in the Number of Morning Teaching Periods field or in the Number of Afternoon 
Teaching Periods field as appropriate. 

 Leave the other fields blank. 
 
In the Period Structure for Lesson Attendance window, enter the sessions for the appropriate days. 

 

Note: Period structures cannot be edited once they have been saved as part of the year 
structure. 

 

3.4.3 Deleting a period availability structure 

 
To delete a period availability structure: 

 Select the structure from the Period Structure Name field. 
 

  
 

 Click the  button to delete the structure. 
 

Note: Period structures cannot be deleted once they have been saved as part of the year 
structure 

3.4.4 Selecting year groups in Lesson Attendance 

Lesson Attendance > Parameters > Year Groups 

During set-up a window will show which year groups available in the Integris database are to be 
included in Lesson Attendance recording. This window is also available through Lesson 
Attendance sidebar > Parameters > Year Groups. 
 
In this example, the window displays the year groups in a hypothetical K-12 school. If all the year 
groups are using Integris this can be indicated in this window by checking the check boxes next to 
each Year. When setting up a new attendance year, each year group must be linked to one of the 
period structures set up in the school. 
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 Tick the check boxes next to all Year Groups that are using Lesson Attendance. You will be 
able to link year groups to different structures in the next step of the process. 

 
 

 Click the Next button. 
 
The Year Groups Using Lesson Attendance window is displayed. 
 

 For each Year group, select the appropriate period structure from the structures you have set 
up. 

 Enter the start and end dates for each year group. The start and end dates can be applied to 
each year group.  These are designed to allow year groups to finish before the end of the 
school year, e.g. where a year group has finished after end of year exams.  

 

  
 

 Click Save to save the data set up. You may now edit the set-up if necessary. 

 Click the Edit Year Groups button  to edit the start or end dates or to change the period 
structure for a year group. 

Note: For Department of Education (WA) schools, the PM Period option is not available.  
The PM Period column is blank and cannot be changed. 

There is a business rule that dictates the recommended session attendance code on the basis of 
the percentage of periods that the student has attended in the session.  This session code can be 

Edit End 
Dates as 
appropriat
e 
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subsequently altered by the user.  The percentage is specified in the Parameters >Defaults 
window, described later. 
 
There is a new variant of the business rule that accommodates the requirement for attendance to 
be recorded at the start of the morning session and once during the afternoon session. 
 
For the new business rule the AM attendance code is determined from the code for the first period 
of the day (either a registration period or a teaching period depending on the period structure) and 
the PM attendance code is determined from a specified afternoon period. 
 
To activate the new business rule the user has to specify which afternoon period will be the 
determining period for the PM attendance code.  This is set in the Year Groups window of the 
Lesson module.  If the user selects a period other than zero then the period selected will determine 
the PM attendance code and the first period of the day will determine the AM attendance code. 
 
If the user selects period zero (the default setting) then the original business rule (based on 
percentage attendance) will apply. 
 
Note that the period number set in Year Groups window needs to reflect the relative column of the 
period as shown in the Day View window (rather than the Teaching Period number).  So, that if the 
period structure for a day is HTTThtt and the period that should be linked to is the afternoon 
registration period, then the period number set in the Year Groups window would be 5. 
 

 Click the Finish button  to complete the process. Press Yes to confirm that you 
have finished setting up Year Groups. The following message is displayed: 

 

 
 

 Read all the notes in the Create New Attendance Year window. Once you have entered 
attendance data in the new attendance year, if you recreate the attendance year the data will 
be deleted and would then need to be re-entered.  

 Click OK to exit the window. 
 
The Attendance Year set-up is complete. 
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4 Creating Daily Records 

Lesson Attendance > Parameters > Create Daily Records 

Attendance records are created daily. The best time to do this is probably late each day, while a 
staff member has several minutes to spend on duties that do not involve use of Integris. Other staff 
can continue using the software while daily records are created. 

Note: It is recommended that you create the daily register only one day ahead.  You may be 
tempted to create several days at once, but if a student enrols or moves between form 
groups during that time, you will not be able to recreate the appropriate attendance sheets 
with the revised registration details as easily as if you create the records daily. You will also 
make it difficult to find students in their current form/teaching set if you create records 
more than one day in advance. 

To create daily records for the school or for individual Year Groups: 
Double click on the Create Daily Records icon. This opens the Create Daily Records window that 
displays all the year groups in the school. On each Year Group line is the date for which current 
records have been created for that Year Group.  Only year groups that are due to attend school on 
the date shown will be displayed in the window. For example, if you open the Create Daily Records 
window before the start of the attendance year, no year groups will be displayed. Change the date 
(e.g. to the first day of the attendance year) and the year groups will be displayed. 
 

  
 

 Enter the date for which you are creating records in the Create New Records Up To field. Use 
the keyboard or the Select Date button.  

Enter the date 
for which you 
wish to create 
records. 

Select Year 
Groups whose 
records you are 
creating. They are 
all selected by 
default. 

Deselect all 
year groups. 
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 Click the Deselect All button to uncheck the check boxes, in the unlikely event that you need to 
create records for only a selection of Year Groups. 

 

 
 

 Click the Create button to create records for the date selected. 
 

Note: There will be instances where students enrol after records have been created for a 
day. The Lates window will create records if they have not already been created. The Speed 
Entry window will create records if they have not already been created. 

Use the Speed Entry window to enter attendance data for students who have enrolled after 
daily records have been created. Once you have done this, the student’s record for that day 
will be displayed in Day View and can then be edited in the usual way. 

 
To minimise Integris and work on other applications while daily records are being created, click on 
the Minimize button in the top right corner of the screen.  
 

 
 
To maximise the screen later, click on the Integris icon displaying the school’s name on the 

toolbar at the bottom of your screen.   
  

Minimize button 
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4.1 Daily records for students with a Part Time status 

During the ‘Create Daily Records’ process as each record is created, the system will check on the 
Part Time status for each session. If a student is marked as “Not in school”, the Session code and 
the Period codes for that session will be given the mark “-“, overriding any Period structure derived 
from Lesson Attendance > Parameters > Period Availability Structure, or from the Timetable Period 
structure. 
Example : 
A student has the following Part Time attendance pattern set up in General>Student 
Details>Additional Information: 
 

 
 
The resulting week view displays the following: 
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5 Recording Attendance Data 
Integris provides schools with several methods of entering data, to ensure the software meets the 
business processes of each school. This section of the manual describes each data entry method. 
 
Daily records are created by: 

 Creating records for some/all year groups in Lesson Attendance > Parameters > Create Daily 
Records 

 Speed Entry: if a student’s record has not been created for the day on which their data is being 
entered in Speed Entry, it will be created for that student on that day. 

 Lates: if a student’s record has not been created for the day on which their data is being 
entered in Lates view, it will be created for that student on that day. 

5.1 Lates 

 

5.1.1 Recording Late Students’ Attendance 

This function enables speedy entry of a late record for a single student at a time, and will print a 
Late Slip if this option is checked on the Lates window. The Lates window may be used at any time 
of the day, and is probably most valuable as a means of recording students’ late arrival at the time 
they arrive.  
 
Data entry is extremely fast and the user has the option to print a Late Slip for the student to take 
to their teacher. All data entered via the Lates window is automatically saved in Integris. 
 
There is no need to be in the Lesson Attendance module to record late arrivals. 
 

 Click on the Lates icon at the top of your screen.  The following window is displayed. 
 

 
 
The cursor defaults to the Student Name (surname) field.  

 Enter the student’s surname, or part thereof. Press <Tab> or <Enter>.  

The code set up for the 
Lates window in 
Parameters > Defaults is 
displayed. All 
periods/sessions prior to 
the period/session in the 
Period field will be 
marked with this code. 
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Note: The standard Find function  is also available for finding students.  It is also 
possible to find students by student reference number. 

 
Where there are two students with the same characters entered in the Student Name field, a 
selection box is displayed. 
 

 
 
The rest of the student data will be given values based on current date and time, a default late 
code and a default attendance code. These can be edited. 

 Edit the Date field if necessary. Overwrite the date or use the Date Selector. To quickly enter a 

date for the current month, enter the day, e.g. ‘28’   and press <Tab>. 
The date will be displayed. Tab to the next field. 

 

 Edit the time if necessary. The field can be left blank if the student’s exact arrival time is not 
known.  Tab to the next field. 

 

 Edit the Period field if necessary. The Period will default to ‘1’ or ‘a’ except for TIME or 
TIMETABLE users where it will default to the current period (this assumes that period times 
have been set in the Timetabling module). 

 

 To mark the period as ‘Late’, press the <Space> bar to check/uncheck the check box. If the 
Mark as Late checkbox is checked, the student is considered to be late for the specified period. 
Late periods are counted as ‘Present’. If the Mark as Late checkbox is not checked then the 
student is marked as present (‘/’) for the period. Tab to the next field. 

 

 In the Attendance Code for previous period(s) field use the keyboard or the mouse to enter the 
appropriate absence code.  

 
If the ‘U’ Attendance Code is entered the student will be marked as absent for all periods preceding 
the one entered in the Period field. If a student is late and has been present for preceding 
periods/session, use the ‘/’ (Present) code for previous periods.  
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5.1.2 Overwriting Future Absence Records 

If there is a future absence record covering the same day, the user will be given the option to 
create the record using either the future absence data or the late data (not both), or to cancel the 
operation. See the following screen shots of Warning messages. 
 

 
 
If the user clicks Yes to the above question and a comment has already been stored in Future 
Absences, the following message is displayed: 
 

 
 
To amend the comment, close the Lates window and open Day View, then load the student’s 
record for the appropriate day. Edit the comment. 
 

5.1.3 Overwriting an Existing Record 

If there are already resolved codes entered for that day, the user will be given the chance to 
overwrite the codes or retain the original codes (ignoring the ‘Late’ entry). 
 

 
   

 The Comment field shows the time of arrival. This can be deleted, or an additional comment 
may be added. Up to 521 characters can be entered in the Comment box. Comments are 
displayed in the Day View window. Brief comments are also displayed on the Morning 
Absentee Report. 

 

 The user has the option to print a Late Slip. See section 5.1.4. To print a Late Slip, tab to the 
Print Late Slip check box and press the <Space> bar. On pressing OK or <Enter> the record 
that has been saved is displayed at the bottom of the window. 

 The Student name and Form fields 
will be cleared ready for the next student. 

 
Alternatively, use the Cancel button to cancel the data entered. The Student name and Form 
fields will be cleared ready for the next student. 
 

 Use the Exit button or <Alt> + X to close the window. 
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5.1.4 Printing a Late Slip 

A Late Slip will print an A4 sheet detailing the following information: Date, Time of arrival, Name, 
Year Group, Form, Comment.  
 
If this function is used, your school may wish to consider printing to a dedicated printer.   
Example: 
 

 
  

The last updated record is 
displayed. 
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5.2 Speed Entry  

 

Lesson Attendance > Speed Entry (Except Northern Territory) 

Lesson Attendance > Absences > Speed Entry (Northern Territory only) 

The objective of this function is to facilitate the speedy entry of data for all students reported absent 
at the initial registration period. This window may also be used for entering end of day absence 
information (variations) and to update attendance codes following notification of a reason. 
 

 Click on the Speed Entry icon on the Lesson Attendance side bar. The following window is 
displayed. [The default settings allow for speed entry of attendance data one student at a time. 
However it is possible to record the same data for multiple students. See the section ‘Speed 
Entry - Enter data for more than one student’ in Section 5.2.2 for details on how to load multiple 
students’ names.] 

 

 
 

Note: To facilitate speedy entry of data the window operates without the use of the mouse. 
<Tab> between the fields. Use keyboard arrows to move down the list of radio buttons to 
select sessions/periods/dates. On pressing OK or Cancel, the Student name and Form 
boxes will be cleared ready for the next student. 

 

5.2.1 Using Speed Entry for a single student 

 Enter the student’s surname or part thereof in the Student name/Reference No. field 

 and press <Enter>.  

 Alternatively, use the Student Find  to locate and load the student’s name. 
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It is also possible to search by the student’s Reference Number. If the student is the only student 
on the current roll with that name, their name, year and form group will be loaded automatically.  

 
 
If more than one student has that surname, the user is presented with a list of students from which 
to select the appropriate name.  
 

  
 
If several names are listed, use the keyboard arrows to scroll to the correct name. Press <Enter> 
to load the student’s data. Alternatively, double click on a student’s name to select and load it. 
 

5.2.2 Speed Entry - Enter data for more than one student 

To enter data for more than one student at a time: 
Select the ‘Enter data for more than one student’ option by placing a tick in the checkbox. 

 This will activate a new pane in the Lesson Attendance – Speed 
Entry window :  

 
 
The window holds multiple students’ names, their forms and a column for the Status code after 
saving. A key for these Status codes appear in the Lesson Attendance – Speed Entry Window. 
 

 
 



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 5-8  

© 2020 Civica Education Pty Ltd  

 

 

 Use the Student Find  to find and load students’ names into the Lesson Attendance – 
Speed Entry window. 

 

 
 
If incorrect students are selected and displayed in the window, their names can be highlighted and 

then deleted using Delete All Students  button.  

 Select the appropriate settings and enter details such as Attendance Code and Comment as 
required.  

5.2.3 Speed Entry session options 

To the right of the Speed Entry window is a range of options from which to choose the appropriate 
session for entering data. The options are: 

 All Day 

 AM 

 PM 

 Periods 

 Range of Dates 
 

All Day 

The default setting is for ‘All Day’. This means the code entered will be recorded for both morning 
and afternoon sessions. 

AM/PM 

AM/PM options are available for entering data for morning or afternoon sessions only. 

Periods 

You can select Periods by clicking on the Periods list button. The will display the following: 

 
There are factors which determine if and how Periods become available for adding: 
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 If multiple students are selected, all selected students must be in the same Year group. 
Otherwise, the Periods fields will not open. 

 If the Year Group is Primary, Periods cannot be assigned – The Periods fields will not open. 

 If the Year Group uses a Lesson Attendance generated Period Availability Structure, the 
system builds a list of periods based on that Structure. 

 If the Year Group uses Timetable-generated Periods, the system builds a list of periods 
based on the periods in the Cycle. 

Once the above conditions have been met selecting the Open Periods list icon  will display the 
Select Periods window: 

The user can select the Periods that need to be marked: 

 

WA Note: The Select Periods window will show the maximum number of periods available 
for the selected student and date.  That is, if a student is timetabled in two Timetable 
Cycles, then the period structure that is shown is the one from the Cycle that the student 
has the most timetabled periods defined for the particular day. 

 Clicking OK will save the selection as shown below: 

 

 

 Clicking OK will save the records down and the Status will change to S for Absence saved 
down. 
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 Click OK and the screen will be cleared for the next selection (Unless Keep data on Committal 
has been selected.) 

Range of Dates 

 
When the Range of Dates radio button is selected, the Date entry box changes to ‘Start Date’. An 
‘End Date’ box also appears. This enables the user to enter an attendance code and a comment 
for a range of dates for students, rather than entering dates individually. The start date and the end 
date default to the current date. The Range of dates function can be used for individual and 
multiple student selection. 

 
 Enter the start dates and end dates for the student’s absence. 

The system defaults to data entry for the entire day (‘All Day’).  
If changed by the user it will stay at the new value for subsequent entries until the window is 
closed. 
 

Note: When using Speed Entry over a Range of Dates for multiple students the Status 
codes in the Lesson Attendance – Speed Entry window change: 
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5.2.4 Speed Entry - Entering details  

 
The Attendance Code defaults to the code set up in Parameters > Defaults - (typically ‘U’) when 
the window is opened. If changed by the user it will stay at the new value for subsequent entries 
until the window is closed. 
 

 To change the default attendance code, tab to the Attendance Code field and enter the key for 
the code, e.g. ‘M’ for ‘Medical/Sick Bay’. Tab to the Comment field if you wish to enter a 
comment. 

 

 
 
 

5.2.5 Speed Entry - Keep data on Committal 

 
At the bottom left of the screen is a Keep Data on Committal check box. If not checked the 
settings, comments and codes will be cleared ready for the next entry when the user clicks on OK.  
 

When checked  the data will stay on the screen.  This enables the user to enter a 
series of similar data quickly.  
 
Example: 
If a student misses Monday afternoon and Tuesday morning, enter and commit the data for the 
Monday afternoon, then simply change the date and the am/pm indicator before again pressing OK 
to make the Tuesday morning entry. 
 

 When all the required data is entered, press <Enter> or OK. Note: On some occasions the data 
that is being entered conflicts with data that has already been saved for the student. In such 
instances the user will be directed to use the Day View window to ensure accuracy of the data 
to be recorded. 
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Notes:  

Where the entry of an attendance code results in the creation of a new record: 

- The new am/pm code will be used for all the period codes. 

- If there is a future absence record covering the same day, the daily record for the student 
will be created using the future absence data and the user will be given the option to edit 
the data with the Day View window. 

Where there is already a record: 

- If the new am/pm code is replacing a Resolved code (not including Lates), the user will be 
directed to use the Day View window. 

- If the codes are not all the same for a session, the user will be asked to use the Day View 
window to edit the codes. 

- If the new am/pm code is a Resolved code (not including Lates), and all the period codes 
for the day are marked as present or unresolved, all the period codes will change to the new 
am/pm code. 

- If a new code relates to a single period and is replacing a Resolved code (not including 
Lates), the user will be directed to use the Day View window. 

 

 If a selected student is not covered by the Lesson Attendance module on the selected date, the 
following message appears: 

 

 
 
The Status Code for the student will be ‘C’ (data entry cancelled). 
 

 If a student already has absences with a ‘resolved’ status recorded (e.g. ‘R’ or ‘E’) and the user 
enters a code with an unresolved status such as ‘U’ in Speed Entry, an option to view the Day 
View window appears. 

 

 
 

 If you do not wish to amend the data, press No. 
 
If the user says Yes, the Day View window appears, the student details can be altered and saved if 
appropriate, and the user is returned to the Speed Entry window. The student Status is updated to 
‘C’ if no change is made in Day View or ‘D’ if changes have been made in Day View.  



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 5-13  

© 2020 Civica Education Pty Ltd  

 

 
 

 If the student has a Future Absence record (e.g. ‘E’ code entered), and the user attempts to 
enter a new code with ‘unresolved’ status a message comes up, offering the user the option to 
view the Day View window.  

 

 
 
If the user says Yes, the Day View window appears, the student details are altered and the 
student’s status is updated to ‘S’. If the user cancels, the student is saved with the Future Absence 
code and the student’s status is updated to ‘F’. 
 
When the messages have been dealt with the processing will continue. Press ‘Cancel’ to cancel 
processing. The processing will stop at the next student. 

 Click OK to continue 
 
On completion of processing for single students, a message will report that saving the record has 
been updated:  

 
 
On completion of this process for multiple students on a single period occurrence or date as each 
record is saved down, the student status is updated in the Status column: 
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When saving data for multiple students over a date range, on clicking OK, the list of students is 
processed one by one: 
 

 
 
If any exceptions exist the user gets the following message: 
 

 
 

 Click ‘Yes’ to view the log: 

 
 Click Print or Close as required. 
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Note: When saving data for single students, students are processed one at a time i.e. the 
attendance code is stored for one student before the user enters the name/ID of the next 
student. This enables immediate feedback of errors and warnings on data already entered 
for the student. The user has only to enter the student’s surname and OK to move on to the 
next record. 

The same applies when saving for multiple students on a single date the system works in 
the same way as for single students and also updates the status column. 

When saving for multiple students over a date range, the system updates the status column 
as before but creates an exceptions log that can be viewed when the process is finished. 
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5.3 Day View   

 
 

Lesson Attendance > Day View 

The Day View window provides access to attendance codes for a selected day, to enable the user 
to enter data by selecting: 
Form 
Teaching Set 
Student Find  
My Form 
My Sets 
 
The My Form and My Sets options will only be activated if the logged on user has been linked to a 
Form Description in General > Parameters > Form Descriptions and /or has timetabled teaching 
sets. 
Many schools will use this window to enter data in the morning and to enter variations later in the 
day. However, Day View is particularly useful for updating attendance data. For example, if 
students are loaded individually when entering variations, their data remains on the screen and can 
be readily accessed to update more than one period’s data as the user reads teachers’ absentee 
sheets for the day.  
To open the Day View window, click on the Day View icon in the Lesson Attendance side bar  
 

 
 

 A date entry box and a date selector are available at the top of the window.  The date defaults 
to the current date. 

 The Periods section of the window differs according to the period structure set up for the 
selected form/student/teaching set. The following two screen shots show the primary and 
secondary view. 
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This displays a typical AM/PM session attendance for a primary class: 
 

 
 

 This displays a typical AM/PM sessions and periods - secondary class, showing the periods as 
set up in Parameters > Period Availability Structure: 

 

 
 

5.3.1 Selecting a Date for Data Entry 

 To change the date and view/enter data for a different date: 

 Highlight all/part of the date  and change the date by keyboard 
entry; or 

 Click on the blue arrows either side of the Calendar button  to move the date forwards 
or backwards one day at a time. The arrows are activated once students are loaded; or 

 Follow directions in section 5.3.2. 
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5.3.2 Using the Select Date button 

 Click on the Select Date button  to select the appropriate date from the school calendar.  
 

 

 
 

 
The current date is shaded green.  

 Use the single red arrows to scroll to different 
months and the double red arrows to scroll to 
different years.  

 Use the Today’s Date button  to select the 
current day’s date. 

 Use the Reset date button  to reset the 
calendar to the previously selected date.  

 Click on the date you wish to use in recording 
attendance data.  

 Click OK. 

 
To the left of the window are six options for selecting students. They provide a range of ways to 
display and enter data. 
 

 
 
 

 
 
 
 

 by Form 

 by My Form (where forms are linked to 
staff and staff are linked to a user) 

 by Teaching set (where these are set up 
in Integris Admin or taken from 
Timetabling)  

 by My Sets (where staff are linked to 
users and a Timetable is - being used) 

 Student Find Tool option – entering the 
name/reference number in Student 
Surname/Ref. No. field 

 Student Find Tool – using Find Students 

button . 

 

Note: By default when using the Student Find tool, new students are placed in the list in 
alphabetical order. In Parameters > Defaults > System Management the option “Day View – Place 
students located via Student Find to the top of the list”, is left unchecked by default but can be 
checked. Students added via the Student Find tool are then added to the top of any existing 
selection. Multiple students are added alphabetically to the top of the list. 
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When the Day view window is operating in ‘Place students located via Student Find to the top of 
the list’ mode and Student find is selected, you can resort the list of students alphabetically 

whenever you want, by clicking on the ‘Sort’   button. 
 The My Form button will look for the forms linked to the logged-on user through Parameters > 
Form Descriptions and display the list of forms in the drop down list.  If only one form is found 
(typical in most cases) then this group of students will be displayed in the main window.  If more 
than one form is found, then the user will have to select the appropriate form from the drop down 
list.   
 
The My Sets button looks for all the teaching sets being taught by the logged on user.  This 
requires the Timetable module to be loaded, otherwise the button will not be enabled.  This button 
populates the list of teaching sets - it then requires a further selection from this list for students to 
be displayed. If only one set is found then this group of students will be displayed in the main 
window. If form classes have been created in timetabling then the form description will display in 
this list as a teaching set. 
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5.3.3 Selecting attendance codes 

Attendance codes are displayed to the right of the window.  
 

 

The code selected for use is highlighted and the code enlarged at the top 
of the Codes pane. 
 
Hover text on the enlarged code provides a description of the code. 
 
The full description for the current code is displayed above the enlarged 
code. 
 

 

Note: F Code is no longer available for WA schools 

 
The Key for the attendance codes is located at the bottom left of the Day View window and the full 
description of the currently selected code is shown. 
 

 Click on the Display Key to Lesson Attendance Codes button  to display codes, 
descriptions and types. 
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5.3.4 Loading data by form in Day View 

 
To load a group of students by Form, ensure the Form radio button is checked. 
 

 
 
To load the students either: 

 Use keyboard entry to type the name of the form or 

 Find the form in the Form lookup list (see above) and click on it to highlight it. 
 

5.3.5 Loading data by Teaching Set in Day View 

 
To find a Teaching Set, ensure that the Teaching Set radio button is checked and either:  

 Use keyboard entry to type the name of the teaching set  
or 

 Find the teaching set in the Teaching Set lookup  
 

   
 

 Highlight and click on it. 

Note: It is not possible to display students with a different period structure at the same 
time.  If you attempt to display a set of students covering two or more Period Availability 
Structures, you will be asked if you wish to switch to the new student selection. Selecting 
Yes will save the previous student’s data and switch to the new browse set. 

  
 

5.3.6 Loading data by individual student in Day View 
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An alternative to loading all students in a form or teaching set is to individually load the students 
whose data you will be editing. As you add a new student, the list of students grows, so you can 
continue editing data for any of the students already on the list. 
 

 
 
To load data for a student: 

 Click on the Student Find Tool radio button. 

 Enter the student’s surname or reference number directly into the Student Surname/Ref. No. 

box  and press <Tab> or <Enter> ; 
 

 
 
The cursor appears in the box, ready for the user to start entering the student’s surname. 

(Alternatively, use the Find Students button  to locate a student). It is also possible to search by 
the student’s Reference Number. 
 

 Enter the student’s surname or part thereof and press <Enter>. If the student is the only 
student on the current roll with that name, their name, year and form will be loaded 
automatically. If more than one student has that name the user is presented with a list of 
students from which to select the appropriate name. 

 

 
 

 Use the keyboard arrows to scroll to the correct name. Press <Enter> to load the student’s 
data. 

Use the Clear 
Student Selection 
button to clear the 
list of students. 
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 Continue to add students to the list and enter attendance data. The list builds, listing the 
students alphabetically. 

 

 

 Clear the list by using the Clear Student Selection button.  
 

5.3.7 Using the Day View screen to add/edit data 

The student’s period availability structure is used to mask the periods available for data entry.  
Non-teaching periods such as breaks, for which the student is not available, are greyed.  
 
When the Lesson Attendance window opens with a selection of students and there is no 
attendance data as yet, the students are shown with the default code for each session and period.  
 
 

 

Student attendance for 
periods and sessions 
(AM/PM) defaults to 
‘present’ (/). 

Display Key to 
Lesson 
Attendance Codes 
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In Day View, AM and PM attendance codes are displayed in a different background colour to 
distinguish them from period codes (where a period structure is used for a student). 

5.3.8 Entering/editing AM and PM attendance codes 

The AM and PM attendance codes are calculated from the lesson attendance codes according to 
the minimum percentage attendance required per session in Lesson Attendance > Parameters > 
Defaults.  See section 8.6.1 for further information and examples on setting up the minimum 
percentage attendance required in your school. 
 
To enter data for a session (AM/PM): 

 Select a code from the Codes panel by clicking on the code. The code is highlighted.  

 Click in the cell for the session in which the code is to be entered. To enter the same code for 
both morning and afternoon sessions, right click in the AM session for a primary period 
structure and in the first column of the period structure for a secondary structure. 

 
Data Entry on the Day View window is designed to be carried out using the columns for the 
periods, rather than the AM/PM columns (unless these are the only columns available).  Where 
there are period columns the administrator will be able to control how users are able to edit the AM 
& PM columns.  The options will be:  
 

 Free entry into these columns 

 Ask the user for confirmation when changing these columns.   
 
Users can override (edit) the AM and PM codes. This does not change the period codes, where the 
period codes are visible. The user makes changes to the period codes manually. 
 
Typically, when a user receives a reason for an absence, this will be used to update the AM/PM 
code and/or the period codes. 
 

5.3.9 Adding and entering period attendance data 

Period data entered in the main Day View window changes the AM/PM attendance code. For 
example, if two out of three AM periods are changed to ‘U’ and the minimum period attendance 
required per session is 75%, the AM code will change to ‘U’. 
 

 
 
To enter data for a period: 

 Select a code from the Codes panel by clicking on the code. The code is highlighted.  

 Click in the cell for the period in which the code is to be entered. 
 

 
 

Click in the cell for 
the period in which 
the selected code is 
to be entered. 
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5.3.10 Using the right-click function – multiple periods 

Right clicking on a cell with a period attendance code will change all codes for periods later in the 
day, e.g. if the user right clicks on period 3 for a student then periods 1 and 2 will remain 
unchanged, while periods 3 to the end of the day will be marked with the new code. 

Note This function can be disabled in Parameters->Defaults->System Management 

 

5.3.11 Adding and editing comments in Day View 

Comments relating to a student’s absence may be entered and edited via Day View. The Day View 
window has a check box for each student to show whether they have a comment for the day.  
 
To add/edit a comment for a student: 

 Click on the student’s check box  in the Comment column  to open a text entry window. 
 

 
 

 Enter the comment. Press <Enter> to move to a new line.  

 Press <Tab> to activate the OK button.  

 Press <Enter> to close the Comment window. 
If a comment has been entered via Speed Entry or Lates e.g. the time the student arrived and the 
reason, it will appear in the comment window when opened in Day View. This comment may be 
edited. The following example shows a comment that has been entered in the Lates window.  

 Place the cursor after the comment to add additional information. 

 To delete the comment, highlight the text and press <Delete> or <Back Space> 
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Note: In Day View, if another user has edited a record that the user has open, a warning 
message is displayed, informing the user that someone else has changed the records. 
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5.4 Week View  

 

Lesson Attendance > Week View 

 
The Week View window provides access to attendance codes for a selected week, to enable the 
user to enter data by selecting 

 Form  

 Teaching Set  

 Student Find Tool  

 My Form 

 My Sets (for Timetable users) 

 Individual Student. 
 
Week View is used for entering and updating attendance data.  

 To open the Week View window, click on the Week View icon  in the Lesson 
Attendance side bar. 

 

5.4.1 Selecting a week for data entry 

The Week View window shows the am/pm attendance codes for a selection of students and a 
given week. The week is selected by the same means as for the Day View window – see the 
section ‘Selecting a Date for Data Entry’ on page 5-17. 
 

5.4.2 Loading data by form in Week View 

To load a group of students by Form, ensure the Form radio button is checked. 
 

  
 
To load the students either: 

 Use keyboard entry to type the name of the form 

 Find the form in the Form lookup list (see above) and click on it to highlight it. 
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5.4.3 Loading data by Teaching Set in Week View 

To find a Teaching Set select the Teaching Set radio button. 
 

 
 
There are two options for displaying data for students in a teaching set: 

 Use keyboard entry to type the name of the teaching set   or  
 

 Find the teaching set in the Teaching Set lookup  

  
 

 Click on the relevant teaching set. 
 
The selected students’ data will be displayed. 
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5.4.4 Loading data by individual student in Week View 

An alternative to loading all students in a form or teaching set is to individually load the students 
whose data you will be editing. As you add a new student, the list of students grows, so you can 
continue editing data for any of the students already on the list. 
 

 
 
To load data for a student: 

 Click on the Student Find Tool radio button. 
 

 
 
The cursor appears in the Surname/Ref No. box, ready for the user to start entering the student’s 

surname (alternatively, use the Find Students button  to locate a student/group of students). It 
is also possible to search by the student’s Reference Number. 
 

 Enter the student’s surname or part thereof and press <Enter>. If the student is the only 
student on the Current Roll with that name, their name, year and form will be loaded 
automatically. If more than one student has that surname the user is presented with a list of 
students from which to select the appropriate name. 
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 Use the keyboard arrows to scroll to the correct name. Press <Enter> to load the student’s 
data. 

 Continue to add students to the list and enter attendance data. The list builds, listing the 
students alphabetically. 

 

 
 

 Clear the list by clicking on the Clear Student Selection button.  
 

Note: In Week View it is possible to display students with different period structures at the 
same time, as only the am/pm data is displayed – not periods. 
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5.4.5 Using the Week View Screen to Add/Edit Data 

When the Lesson Attendance window opens with a selection of students and there is no 
attendance data as yet, the students are shown as ‘Present’ for each session.  
 

 
 

5.4.6 Entering / Editing AM and PM attendance codes 

To enter codes for am/pm sessions, select the appropriate code from the Codes panel on the side 
of the Week View window and click in the student’s AM/PM cell for the appropriate day. 
 

 
 

Student 
attendance for 
periods and 
sessions 
(AM/PM) 
defaults to 
‘present’ (/). 

Display key for 
Lesson Attendance 
Codes 

Select a code from the list of codes on 
the right of the window and then click in 
a session code cell to enter the code 
for a student’s AM/PM session/s. 
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Where students have a structure that includes periods, any changes made to am/pm attendance 
codes in this window will be reflected in the period attendance codes stored for the student. For 
example, if a student has a code ‘R’ entered for a morning session, their morning periods for that 
day will display the same code (R) in Day View. 
 
Enter comments in Week View by right clicking on either the AM/PM session for the appropriate 
day.   
 

 
 
The Comment window opens. See the section ‘Adding and editing comments in Day View’ on page 
5-25 for more information on entering comments. 
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Note:  

- The Week View window will not display Saturday or Sunday if these days have not been 
selected in the Timetable Cycles for Attendance window, when setting up the attendance 
year.  
- The window will display data for calendar weeks (Monday - Sunday) rather than timetable 
weeks. 

On some occasions the data that is being entered conflicts with data that has already been 
entered for the student. In such instances the user will be directed to use the Day View 
window to ensure accuracy of the data to be recorded. 

Where the entry of an attendance code results in the creation of a new record:  
- The new am/pm code will be used for all the period codes. 
- If there is a future absence record covering the same day, the daily record for the student 
will be created using the future absence data and the user will be given the option to edit 
the data with the Day View window. 

Where there is already a record: 
- Where a new am/pm code is replacing a Resolved code (not including Lates), the user will 
be directed to use the Day View window. 
- Where the codes are not all the same for a session, the user will be asked to use the Day 
View window to edit the codes. 
- Where a new am/pm code is a Resolved code (not including Lates), and all the period 
codes for the day are marked as present or unresolved, all the period codes will change to 
the new am/pm code. 

Where a new code relates to a single period and is replacing a Resolved code (not including 
Lates), the user will be directed to use the Day View window. 

Example: the following data has been entered in Day View for a secondary student. 
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The user attempts to enter a code ‘Z’ for the AM session in Week View. The following 
message is displayed. 

 

If this happens, click YES to go to the Day View window and view/amend the period codes. 
On Exiting the Day View window you will be returned to Week View. 
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5.5 Registration 

 

Lesson Attendance > Registration 

 The Registration option allows users to register that attendance data has been recorded. For 
this function to work effectively, teachers will need to be set up as users and must be linked to 
staff in General > Control > Users > Staff Link. The Registration Window will automatically 
display the User’s staff code as set up in Staff Details. The date will default to the current date 
and the teaching set that the logged on user is scheduled to teach (based on the current time) 
will be displayed in the Group field. 

 

5.5.1 Using the Registration window 

 Log on to Integris with standard User Name and Password and click on the Registration option.  
 

5.5.2 Schools with Mixed Attendance Groups 

Schools that have a mixed setup using both timetabled and non timetabled attendance groups on 
clicking the Registration option the user will be provided with the following window: 
 

 
 

 The user should select the appropriate year to work with and click OK. 
 
The following window will then be displayed: 
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Note: There is a different window for non-timetabled groups/schools. (Refer to section 5.5.3) 

 If the user wishes to record attendance for another day, the date can be changed. 

 By clicking on the Form or Group drop down list the user can select the classes they wish to 
register.  

 Click Register to continue 
 

Refer to Section 5.5.5- for further details on Registration 

5.5.3 Non-Timetabled Schools 

For schools not utilising the timetable module for the attendance groups the following window will 
display after clicking on the Registration option: 
 

 
 

 If the user wishes to record attendance for another day, the date can be changed. 

 Clicking on the form drop down list the user can select the classes they wish to register. 

 Click Register to continue 
 

Refer to Section 5.5.5 for further details on Registration 
 

5.5.4 Timetabled Schools 

For schools only utilising the timetable module for the attendance groups the following window will 
display after clicking on the Registration option: 
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 If the user wishes to record attendance for a class not scheduled for that day the date can be 
changed. 

 The Group list will be populated with the teaching set list for the corresponding date. 
 

  
  

 Click Register to continue 
 
Refer to Section 5.5.5 for further details on Registration 
 

5.5.5 Registration General 

 With the required date and group/form selected after clicking on the Register  
button to the Day View window will open. The only column in this window that can be edited is 
the column for the chosen period. 

 The ability to use the right mouse click function is available in this window but can be disabled 
in Parameters > Defaults > System Management. 

 Although the Calendar navigation arrows are active in this window, moving from the chosen 
date and group will display a window that cannot be edited. 
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 After recording attendance in this window click on OK to save the register and any changes to 
attendance. Even if no changes are made to attendance, the user must click OK to create an 
entry in the Audit log. 

 A confirmation message will be displayed 

 Click on OK again to confirm that register has been taken. OK will take you back to the Day 
View window and Exit to return to the Registration Window. 

 

 
 
If a school chooses not to have teachers registering personally, an authorised user can still use 
this function. 
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 When the user first opens the Registration function the Staff Code will be blank. By using the 

spy glass  adjacent to the Staff Code field, the user activates the Staff 
Search window to locate the required staff member. 

 Once the staff member has been loaded, their teaching sets will now be available from the 
Group drop down list. 
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6 Absences 

Lesson Attendance > Absences 

 

6.1 Absence Follow Up 

Lesson Attendance > Absences > Absence Follow Up 

 
 
Absence Follow Up provides schools with the ability to trace all unresolved absences until 
resolved. This involves a series of communications with the student/parent/guardian. These 
communications are recorded.  
 

 Click on Absence Follow Up. This will open the Absence Follow Up Selection window:  
 

 
 

 Select the date range to be followed up. Either enter ‘from’ and ‘to’ dates using the keyboard or 
use the Calendar buttons to locate the appropriate dates for tracking. See section 5.3.1 for 
details on using the Calendar. 
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 On opening the Absence Follow Up Selection window, the default set of students is the whole 
school. 

 Use the New Query button to select the student/s for absence follow up. This opens the 
standard Student Search window. Select students. To find all students click the Find button. 

 

 
 
The set of students will be identified in the New Query field.  
 

  
 

 Click OK to load the students.  
 
If no absence data is available for the selection the following message will display: 
 

 
 
If the Date range and Query are valid and absence data does exist then the Absence Follow Up – 
Daily Absences window opens, displaying absence data for the selected students for the selected 
date range. 
 



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 6-4  

© 2020 Civica Education Pty Ltd  

 

 
 
The ‘Unauthorised Code used when searching for absences’ field displays the option set in 
Parameters > Defaults > Absence Letter (See Section 8.6.2) 
Students are sorted by surname. To sort students by another field, click on the column header for 
the field by which you wish to sort. 
 
Example: To sort the data by the date the last letter was sent, click on the column header “Date of 

Last Letter”  
 
For the selected date range: 

 The New column refers to the number of day records containing unresolved absences that 
have occurred since the last letter was sent. 

 The Followed Up column displays for each student the number of day records containing 
unresolved absences for which letters have already been sent. 

 The Total column indicates the number of total absences (New and Followed Up) for each 
student, within the date range. 

 
There are further options available in the Absence Follow Up – Daily Absences window: 

  
 

6.1.1 Viewing details of absences 

Lesson Attendance > Absences > Absence Follow Up > Open Student View 

The ‘Open Student View’ function can be used to view the unresolved absences for a selected 
student. This function is used for one student at a time. 

 Select a student for whom you wish to view more detailed records of the unresolved absences. 
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 Click on Open Student View . The Student View window opens, displaying the 
data:  

 
 

Note: Double-clicking on a student’s name in Absence Follow Up will also open the Student 
View window. 

 

 View or Edit the student’s data if required. 

 Click Exit to close the Student View window. 
 

6.1.2 Printing details of absences that require follow-up 

Lesson Attendance > Absences > Absence Follow Up > Print Student View 

The ‘Print Student View’ function  can be used to print a list of the unresolved absences for a 
selected student. This function is used for one student at a time. 

 Select a student for whom you wish to view more detailed records of the unresolved absences. 
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 Click on Print Student View .  

 Select the print option required and click OK.  

 
 
The report shows the absences in the selected date range that require follow-up.  
 

 
 

6.1.3 Viewing a student’s Letter History 

Lesson Attendance > Absences > Absence Follow Up > Letter History 

The Letter History function provides a summary of absence letters sent for selected students over 
a selected date range. 

 Select the student/s by highlighting their name/s on the list. The list can be sorted by clicking 
on column headers. To select several students press the <Ctrl> Key and click on students’ 

names on the list. To select all students on the list click the Select All . 
 

 
 

 Click on Letter History  

 Select the print option required and click OK. 
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The Letter History Summary displays the following information: 
 

 
 

6.1.4 Producing a Follow- up Letter 

 
Integris provides a function to produce follow-up letters for a selection of students for selected 
dates. 
To produce a letter for one/more student/s 

 Select the student/s by highlighting their name/s on the list. The list can be sorted by clicking 
on column headers. To select several students press the <Ctrl> Key and click on students’ 

names on the list. To select all students on the list click the Select All . 
 

 
 
List of students sorted by New column to indicate students who have unresolved absences that 
have occurred since the last letter was sent. Students with new (unresolved) absences have been 
highlighted. 

 Press Follow-up Letter . 

 Press Yes to confirm that you wish to print the letters for the selected students.  
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 Choose the Printer as the print destination, or the screen if you wish to view the letters on 
screen prior to printing them. You will be asked to select the recipient/s from the following 
options: 

 

 
 

 Click the radio button for the recipient/s of your choice.  

 You have the option of selecting either Letter 1 or Letter 2 (as set up in Lesson Attendance 
Parameters > Defaults > Absence Letter). Click on the appropriate radio box. At this point there 
is an option of editing the text in the body of the letter/s for the selected students.  

 Edit the text as required.  

 Click OK. 
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Note: If you are printing a letter that has already been sent on the current day, for a selected 
student, the following message will be displayed: 

 

Click Yes to print another letter or No to cancel the printing of the letter for that student. 

If one/more of the students do not have a parent/guardian flagged for the selected letter 
destination, the following message will be displayed: 

 

In this example the user had chosen to send the letters to parent/guardian marked as the 
Family Mail Marker. 

 

Note: If printing letters for more than thirty students, the system will divide the printing of 
letters into batches. 

 

Click OK and the following message will be displayed. 

 

The system will automatically keep printing batches until all the selected students have had 
letters printed. 

 
The letters will be printed and the Date of Last Letter will be updated for the selected students. 
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 Click Exit to close the window. 
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Sample absence letter for a student with a five - period day period. Note that for a student with 
AM/PM attendance, there would be no period data. 
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6.2 Absence Tracking 

Lesson Attendance > Absences > Absence Tracking 

The Absence Tracking function allows the user to generate a list of students who meet specific 
absence criteria. Absence Tracking is accessed through the Absences window.  
 

 
 
 
The User will need to: 

 Set the required date range. This can be done by either using the date selector at the end of 
each of the date fields or can be keyed directly into the fields 

 Select the students to be tracked by activating the Student Search function 

 Set the cut-off criteria by keying in the half-day cut-off criteria, selecting from the drop down list, 

the operator ,  

 the form of the output required   

 and how the cut-off is to be determined  
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6.2.1 The Absence Tracking Screen - Details 

 
The Absence Tracking details screen will default to sorting the list of students by surname. Clicking 
on any of the column headings will change the sort order to ascending based on the column 
chosen. 
 

 
 
The details screen will display the following information: 
Absence Selection: The message will contain some of the criteria used in the selection process to 
explain the screen output. 
 
Search Criteria: This will display the criteria used in the Student Search to locate the required 
browse set. 
 
Print Report: This will generate a hard copy of the Absence Tracking detail window.  
 
View Details: This will only be active when a student has been highlighted in the details window. It 
will open the Student View window and default to “All days with absences” for the date range 
previously set and display the period structure linked to that student’s year group. 
 
Print Details: This will print the Student View for the selected student, showing all absences 
between the dates specified. It will display the period structure linked to that student’s year group. 
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6.3 Absences in Common 

Lesson Attendance > Absences > Absences in Common 
This functionality identifies other students who were absent when a selected student was absent. 
This is based on a selected date with matching at the session or individual period level.   
 

 “Absences in Common” is an item available in the Absences menu. 
 

 
 

 Clicking on Absences in Common. This will open the “Absences in Common – Select” window 
 

 
 

6.3.1 The Absence in Common - Select window 

 
Select Student:  

 Clicking on this icon will open the standard Student Find window. 

 You can also select a student by entering the initial letters of the Surname, or the Student 
Reference in the Name field. 

 You can only select one student at a time. 
 
Date 

 Enter the date of Absence 
 
 
 

Find Students  

Defaults to today’s 
date 

Select one or 
many codes to 
report on 
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Codes to be checked  

 Choose which codes you want to search on. 

The Search 

 When you click OK, the system first checks that the student you have selected does have the 
selected code(s) in their record for the Date, either as a Session (AM/PM) code, or as a Period 
Code. 

If the student does have a valid record, then a second search is done:  

 The system will only find students who have the same Period structure as the selected student. 

 For each Session and Period code, where the code is included in the “Codes to be Checked” 
selection, the system finds all the students who have a code from the “Codes to be Checked” 
selection for the same Session or Period. 

For instance, you have selected “Unauthorised” codes, and the selected student is absent on 
Monday Period 3 with the unauthorised code “U”. The system will find all students who are 
absent on Monday Period 3 with Unauthorised codes. 

 
The found list is displayed in the Students in Common – Display window. 
 

 
 

6.3.2 Absences in Common – Display Sorting the Other Students List 

It is possible that there could be a large number of students who have absences in common with 
the selected student. For this reason sorts have been put on the column headers that will allow you 
to group the students for any Session and Period. When you click on the column headers, the list 
will sort in Descending order, forcing any “Present” or other non-alphabetical codes to the bottom. 
There will also be default sorts on Year Group and Name. 

Filtering the list 

When you click on the AM, PM or Period column headers of the selected student’s details, the 
Other Students list will be filtered by whatever value is in that column. 

Print 

 This will print the report based on the filtered and sorted list. 
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6.4 Continuous Absences 

Lesson Attendance > Absences > Continuous Absences 

The Continuous Absence Report is accessed through the Absences  menu. The report is activated 
by double clicking on the Continuous Absences option in this window. The report will display 
students who meet the absence requirements as entered in the Continuous Absence window. 
 

 
 

6.4.1 To Generate the Continuous Absence Report 

 After double clicking on the Continuous Absence function, the following window will open. The 
screen will default to the current date, all Year Groups and minimum of two days absent on an 
Unauthorised absence. 

 

 
 

 Set the From and Up to date range by either using the Date Selector and the end of each field 
or enter the date via the keyboard. 

 Click on the down arrow to choose a particular year group to report on or leave the default as 
All to select all year groups for the school. 
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 Set the Minimum number of days absent by highlighting the field and entering the required 
number. 

 

 
 
If “Only report on all day absences” checkbox is checked, a subtitle will appear on the ‘Continuous 
Absences’ window which will read ‘Full days absences only’. This will allow users to distinguish 
between the two variants of the Continuous Absence utility. 

 
 

 The last option is to check the type of absence/s to be reported.  This area uses a set of check 
boxes so a combination can be checked to generate the required report. 

 
 

 Click on OK to view the list of students meeting the absence criteria: 
 

 
 
The list will default to display the students in alphabetical order by surname. Any of the column 
headers can be clicked to change the sort order. The date columns will display the start and end 
dates for the longest period of absence that meets the criteria entered against the minimum 
number of days absent. 
 

 To view a student’s continuous absence data, highlight the required student and click on the 
Details button. This will generate the version of the Attendance Summary report 
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 The Print button will generate a hard copy of the on screen display: 
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6.4.2 Continuous Absences – Mail Merge Export 

An Export facility is available in the Continuous Absences  window to export attendance data so 
that it can be used in Mail Merge software. A CSV or tab file can be produced which you can use in 
documents of you own design. 

 Click on Export to File . The following window appears: 

 

The Continuous Absence Export window 

 

Select the Contact to be included in the Export 
Select which type of Contact you would like to be included in the file. If you select “Parent/Guardian 
of” every exported record will include this text in the Contact Surname field. 
When you click on “Export” the Omnis file path window will open, allowing you to change the file 
name and file path if required. Click on “Save” to complete the export. 
 
Student Fields exported  
These will be the same fields that appear in the Continuous absences window, i.e. Reference, 
Student First Name, Student Surname, Year, Form, Absence Start, Absence End, Days 
 
Contact Fields exported 
Contact Title, Contact Initial, Contact Surname, Contact Address1, Contact Address2, Contact 
TOWN, Contact County, Contact Post Code, Primary Contact Number (this is the number as 
denoted by the ‘red telephone’ icon in Student Details). 

Continuous Absence Export File options and defaults  

 Export Header row - If this is selected the first row of the export will contain all the headers as 
defined below. 

 Format: If CSV is selected, the “Save as Type” shown on the File Path window will be “*.csv”. 
If “Tab delimited” is selected, the “Save as Type” shown on the File Path window will be “*.prn”. 

 File Name: This defaults to “AbsenceExport”. 

 File Path: This defaults to the pathway set up in General > Control > Preferences > Paths > 
Export directory. If no directory is set up, the file path defaults to your Integris directory. 
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6.5 First Day of Absence 

Lesson Attendance > Absences > First Day of Absence 
 

 
 
This function will list those students who have an unresolved absence recorded against them for 
the date and session specified (i.e. AM or PM session). By default the previous session can be up 
to 7 days prior to the selected date. The Year Group field automatically defaults to All, but the user 
can choose any year group from the drop down list.  
 
All those students who are absent (with an unauthorised absence code) in the selected session but 
were present in the previous session are identified.  The report includes contact details for carers 
of these students. 
 
By default the search is for students who were marked as present on the previous session.  This 
can be adjusted to include approved absences, authorised absences and/or unauthorised 
absences. 
 
The students identified are presented in a list.  The user can print the list of students and their 
contacts, or call up the contact details for the student as displayed in the Student Emergency 
Contact window. 
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6.5.1 To Generate the Parent/Carer List on First Day of Absence 

 
This Report can be accessed from Lesson Attendance > Absences > First Day of Absence. 
 

 
 
Without changing any settings, this report will list all students who have been marked as absent in 
the PM session for the date specified but who have been recorded as present in the previous 
session i.e. the AM session of the same day. 

 The Year group can be filtered to choose a selected year group in the school or use the default 
All. 

 

 
 

 Select the options for listing students in the report by checking the required box/es. 
 

 
 
The default is to list students who have been marked as present in the session previous to that 
specified in the “Select” area of the window. Any combination can be used in this section to 
generate the report but at least one box must be checked. 
 

 Clicking on Ok will generate the list of students listing their form, previous and current code 
based on that date and also the parent/carer name and telephone number. 

The list can be sorted by clicking on the relevant column header (except Phone and Mobile) 
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The Previous Code column is populated with the code based the selection screen. 
 

 
 

Note: The previous session is normally the previous afternoon, but may be the morning of 
the previous day. If, when looking for the previous code for a student, there is none found, 
the system will look back through the records until it finds something. It will look back for 
the number of days selected by the user. If no Previous Code is found, the Student will 
appear with the Previous Code “n/a”. 

 
The current code assists the user to determine if the pupil is absent or if they simply have not been 
marked (for whatever reason).  

Note: The current code is used to prevent users phoning up parents whose children are in 
school but they have not been marked.  
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 Click on Print to generate a hard copy of the current screen: 
 

 
 

 Highlight a student in the list and click on Contacts. The student’s Emergency Contact details 
are displayed. 

 

 
 

 When you click on the View Details, the Student View window for the selected student is 
opened. 

 You can also double-click on the student to open the Student View window. 
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6.6 Future Absences 

Lesson Attendance > Absences > Future Absences 

This feature of Lesson Attendance provides a function to allow the entry of known absences in the 
future within the current School Year.  This enables schools to maintain data on absences such as 
planned excursions, suspensions and sports activities. Future Absence records can be set up prior 
to the start of the attendance year. 
 
When daily lesson attendance records are created, if there is a Future Absence record for the 
student then the attendance code in the future absence record will be used for both the periods 
and the sessions. 
 

6.6.1 View Future Absences  

 Click on Absences in the Lesson Attendance side bar.  

 Double click on Future Absences  in the Absences window. This opens the Future Absences 
window. 

 

 
 
At the top of the window is a tool bar: 
 

 
 

Print 
Future 
Absences 
List button 

Filter 
Future 
Absence
s List 
button 

Show/Hide 
Expired 
Records 
button 

Add Future 
Absence 
Records 
button 

Delete 
Selected 
Absence 
Records button 
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The Future Absences window displays Student Reference Numbers, Student Names, Year, Form, 
Start and End Dates, Absence Codes, whether the absence record has expired, and recorded 
comments. 
 
If a student changes Form group before the date of the absence, the discrepancy will be reported 
when creating daily records for the day of the future absence. The user has the option to 
include/discard the Future Absence entry for the student. 
 

 
 

6.6.2 Adding Future Absences 

To add records of absences anticipated for dates later than the current created daily records 

 Click on the Add Future Absence Records  This opens the Future absences – Add window 
and defaults to the Future Absence - Basic Settings option: 

  

 
 
Future absences can be added using the Future Absences – Basic settings option (default) or 
Future Absences – Advanced settings 
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Future Absences – Basic Settings 

 Click on Find students  to select the students for whom you will enter future absences. As 
the button is highlighted when the window opens, you can simply press <Enter> to open the 
Student Search window. 

 Find and select the require student/students: 
 

 
 
The students will be listed in the Future Absences – Add window: 
 

 
 
Users are able to enter absences for a date range, for multiple students, and be able to specify, 
within that date range which days or time of day the student will be absent. 
 

 <Tab> to the From field to enter the start date for the absence. Select the date of the first day 
the student/s will be absent. You will need to indicate whether the absence begins in the 
morning or the afternoon of the selected date. See section 5.3.1 for information on entering 
dates. 

 

 <Tab> to the Until field to enter the date of the anticipated end of the absence. Select the date. 
You will need to indicate whether the absence begins in the morning or the afternoon of the 
selected date. 

 
 

 <Tab> to the Attendance Code field and use the keyboard to enter the appropriate attendance 
code for the absence, or select a code from the drop-down menu. 
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 <Tab> to the Comment field and add a comment (optional). 
 

 
 
Attendance Codes available for use in Future Absences are as Follows: 
 

 X – Unacceptable reason 

 R – Reasonable Cause 

 E – Educational Activity 

 M – Medical/Sick Bay 

 C – Cultural/Religious 

 N – Notified as Sick 

 V – Authorised Vacation 

 K – Unauthorised Vacation  
 
To keep the data displayed for further future absence entries, click the Keep data on saving 
check box. To clear the fields after saving, do not click the check box. 
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Future Absences – Advanced Settings 

This screen is more flexible in allocating Future absence and  

Click on Use Advanced Settings . The following is displayed: 
 

 
 
The user has the option of selecting specific days for the date range selected. The days that 
appear here will be based on the days selected in the Timetable Cycles function. 
 

 Click in checkbox next to the required day/days.  
Or  

 Click on All Week  to propagate the checkbox for every day. 
 

 
 
There are four options for the part of the day that the future absence will take place. 

 AM only 

 PM only 

 All day 

 Or Periods  
 

 For AM, PM or All day click on the required radio button. 
 

 
 

 For Periods click on the  button. 
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The following will be displayed: 
 

 
 

 Click the Add Periods List button  
 
The Select Periods window will be displayed: Users can then select the periods for which the 
student will be absent e.g. 
 

   
 

 Click OK 
 

WA Notes: The Select Periods window will show the maximum number of periods available 
for the selected student and date.   That is, if a student is timetabled in two Timetable 
Cycles, then the period structure that is shown is the one from the Cycle that the student 
has the most timetabled periods defined for the particular day.  
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 <Tab> to the Attendance Code field and use the keyboard to enter the appropriate attendance 
code for the absence, or select a code from the drop-down menu. 

  

 <Tab> to the Comment field and add a comment (optional). 
 

 
 
To keep the data displayed for further future absence entries, click the Keep data on saving 
check box. To clear the fields after saving, do not click the check box. 
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Saving Future Absences 

 Click Save  to save the data. A message is displayed: 
 

 
 
The data will be saved for all students listed in the window.  

 Click OK or Press <Enter>. 
 
If you checked the Keep data on saving check box you will now be able to enter further data 
using the saved Students/Future Absence data.  
If a future absence record entered clashes with a record already entered, a message appears 
advising the user that there is a clash. The user has the option to save the new entry and delete 
any previous entries that clash or to opt not to save the new entry. 
 
In Future Absences – Basic Settings mode the following message displays: 
 

 
 
In Future Absences – Advanced Settings mode the following message displays: 
 

 
 

 Click Yes to overwrite the old entry with the new or No cancel the future absence entry for 
each student in the browse set. 

 

 Click Exit to close the window. The future absences will now be displayed in the Future 
Absences window. 

 
When changes are made to a student’s record by clicking ‘Yes’ to replace previously entered future 
absences the following message appears: 
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To view more data in any of the columns, place the cursor over the edge of the column header until 
the cursor changes shape. Drag the column header to the required width. 
 

6.6.3 Sorting Data in the Future Absences window 

To sort the data in the Future Absences window 

 Click on the column header for the field by which you wish to sort the data. For example, to sort 

by student surname, click on the column header “Student Name”.  
 

 
 

6.6.4 Edit Future Absences 

The ability to edit details in the list of saved future absences is available by selecting the edit icon 

in the Future Absences window.  

 When you click on this icon, or double-click on an individual student, you will open up the 
Future Absence Edit window. 

 Multiple records can be edited provided they have the same time periods and attendance 
codes 
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The Future Absence edit windows for an individual or multiple students. 
 

   
 
This window opens with the current Future Absence settings for the selected student. 
 

 Make all the required changes and press “Save” to save these changes. 

 If you click on Exit without first saving, no changes will be made to the Future Absence record. 
 
If multiple records have been highlighted, and the records do not all have the same time period and 
attendance codes, the following message will appear when you click on the edit icon 
 

 
 

6.6.5 Filtering the Future Absences List 

This function enables users to view selected future absences records. 

 Click on the Filter Future Absence List button . This opens the Filter Future Absences 
window. 

 Enter the criteria by which to search, for example you might be searching for all future 
absences for Form Group “10.1” between the 01November and 04 November: 
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  Click Apply Filter . The selected students will be displayed: 
 

 

 Click the Clear Filtered Selection button  to clear the list and revert to the list of all future 
absences. 

6.6.6 Printing a Future Absences List 

To print a list of recorded future absences: 

 Click on the Print Future Absences List button.  

 Select the printer destination. 

 Click OK. 
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6.6.7 Viewing and purging expired absences 

Once future absences have been incorporated into the main data files (on creation of Daily 
Attendance records) and their end date has been reached, the future absence records will be 
marked as expired. Expired absences records are identified in the Expired column of the Future 
Absences window.  

 To view expired absences click the Show/Hide Expired Absences button.  
 

 
 

 To delete records that have expired press the Purge Expired Records button. 

  

 To hide expired absences press the Show/Hide Expired Absences button. . 
 
The window opens with Expired Records hidden. 
 

6.6.8 Deleting Future Absence Records 

There will be occasions when future absences that have been saved will need to be deleted, e.g. if 
a school excursion has been postponed/cancelled. 
To delete selected records: 

 Highlight the record/s to be deleted. To select more than one record, hold the <Ctrl> key and 
click on the records. 

 

 
 

 Click on the Delete Selected Absence Records button.  

 Click Yes to confirm that you wish to delete the selected record/s. 
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6.7 Import Absences XML File 

The Import Absences XML File function allows the user to import attendance data from an 
appropriate import .xml file that has been created through an external application. 
 
The import process identifies the school from a value within the file. The identifier is the four digit 
school code. 

The data imported includes 

 Information to identify the student (Student Reference Number) 

 Date or dates of absences 

 Sessional absences for each applicable date (e.g. Period 1, Period 2, Period 3 etc.) or half 
day absences if Timetable or Secondary structure is not in use 

 Data based on existing Absence Codes (U, X, R, T, E, M, L, C, Y, N and V as well as the   
Present Code ‘/’) 

 Comment (Reason for absence) if available. 

6.7.1 Validation Rules 

A check is built in to ensure the Daily Records have been created before importing data.  If Daily 
Records have not been created for the dates of any absences in the import file, then the import 
routine triggers the creation of Daily Records up to and including the current date. The import 
checks the school diary and only imports data up to and including the current date for any open 
day as displayed in the School Diary.  If data is entered for a closed day a warning message 
advises the user to review the import file and correct the problem in either the import file or School 
Diary before the import can proceed.   

Any Z (Suspended) or W (Withdrawal) codes found in the import file are ignored. Z and W codes 
can only be entered / edited through the Behaviour Module. 

Any codes found in the import that do not match the current set of attendance codes as set by the 
Department are written to an exception report. 

A log report is produced displaying any code that has been updated to another code, provided the 
original code was not the Present Code.  The report provides the previous code, new code and 
date and time changed.   

The import process does not require the data file to be in Single User Lock and any user who 
triggers the import receives notification of all validation/warning/log messages and reports. 

All log files and exception reports are saved to the Outbox. 
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6.7.2 Import Absences XML File 

Lesson Attendance>Absences>Import Absences XML File 

 

 

 Double Click on the Import Absences XML File option 
 

 
 

 Double click on the required file 
 
The default path on opening this window is the Import Directory as defined in 
General>Control>Preferences>Paths. 
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6.7.3 Filename Convention 

The expected file name will be of the format: 
 

Character Text Notes 

1 – 10 laabsences Any case will be acceptable 

11 _  

12 – 15 <School Number>  School number for the importing school, as defined in 
Integris > School Details. 

16 _  

17 - 24 Date of export <YYYYMMDD>    e.g., 20130114 

25 _  

26 – 29 Time of export HHMM (24hr time)   e.g. 1330 

30 - 33 .xml .xml extension 

 
The warning message appears if any of the following are true: 
 

  The first 10 characters text of selected import file is not: ‘laabsences’. 

 The import file does not have an ‘xml ’extension. 

 The import filename is not 29 characters in length, (excluding the .xml extension). 
 

 
 

If the school number in Integris > School Details does not match the 12th to 15th characters of the 
import file then the following message appears: 

 
 

If either of these messages appears the import stops at this point. 
 

6.7.4 Previously Imported File 

When an absences import file is selected for import and that file has been previously imported then 
the following message will appear 
 

 
 
The import stops if No is selected. The import will continue if Yes is selected. 
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6.7.5 LAAbsences XML File Structure Validation 

If the selected import file has the correct filename format, then the import process continues to 
check the structure of the file.  If the structure does not comply with the structure defined in Section 
6.7.6 then the import routine displays a Warning message: 
 

 
 

The import will stop at this point once the user clicks OK. 
 

6.7.6 LAAbsences XML File Business Rules 

Business Rules 

 If the name in the <DocumentName> does not match the text “Student Absences Transfer 
File”, (case insensitive), then the following message will appear and the import will stop. 

 

 
 

 The Import Absences XML Import will only import absences for the current attendance 
year. If the value in the <Year> tag does not correspond to the year for the latest ‘Created 
Up To’ date shown in Lesson > Parameters > Create Daily Records then the following 
message appears: (2012 text taken from an import file). 

 

 
 

 If a user has already imported a file with a later Date and Time stamp (characters 17 to 19) 
than the selected import file then there is the possibility that absences could over-write 
changes already imported. This could be the case for different dates or different times for 
the same date. If this is the case the following message appears: 
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 The attendance code for the corresponding session in the lesson attendance module will 
always be updated to match the absence code for that date and period in the import file. 

 For example the import file contains a whole day absence for Monday 11th February 2013 
with the code R.  The current code in the LA module for that child on that date is U. After 
import the attendance code for that child is updated to R for the whole of the 11th February 

 There is one exception to the previous rule. Existing periods or sessions that have the Z or 
W code will always be retained in the Lesson module. These codes are managed through 
the Behaviour Module and will be not be overwritten by a different code in the import file 

 Imported comment text will be added to existing comments, if any already exist for the 
appropriate date of absence. 

 Where an absence in an import file is for particular periods, then where those are imported 
as expected to the Lesson Attendance module, the AM and or PM session codes will be 
updated in the same way as if the data had been entered through the Lesson Attendance 
windows.  
For example the import file contains  “U” code absences for the first two morning periods H 
& 1, plus another for the first 2 afternoon periods H and 7, then the import will update the 
AM and PM session codes to U. 

 

 
 

6.7.7 LAPupilData Section 

This section must contain at least one <Pupil> tag. 

6.7.8 Pupil Section 

The <StudentRef> and <Absences> and at least one <Absence> tag is mandatory for each 
<Pupil> section. 
 
The data in the StudentRef tag will be used as the student identifier for finding a matching student 
on the current roll in the Integris data file. If a matching student is not found or no Student 
Reference number is present in the StudentRef tag, then no absence data will be imported for that 
particular student. 
 
The Surname, First name, DOB, & Gender tags are all optional to make student identification 
simpler in the XML file for support purposes. The absence data will import where these tags are 
not present in a Pupil section. 
 
There will be no additional checks that the student name details match the details for the same 
matching student found in Integris. 
Absences will be imported into Integris based on the Student Reference Number details in Integris 
matching the details in the import file. 

6.7.9 Absences Section 

Each Absences section must have at least one Absence tag. 
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6.7.10 Absence Section 

The <Date> tag and at least one <Periods> tag is mandatory for each <Absence> section. 
The data held in the Date tag must be in the format YYYY-MM-DD. 
 
Absences are only imported for dates up to and including the current date.  Any future absences in 
the import file will be ignored and added to the error log. 
 
Where an absence spans a range of dates including past and future dates, the absences in that 
range that are in the future will be added to the error log and not imported.  

6.7.11 Periods Section 

The <Code>, <PeriodFrom> and <PeriodTo> tags are all mandatory for each <Periods> section. 

Code 

The valid codes that can be imported are the current set of attendance codes as shown in Lesson 
Attendance > Parameters > Attendances Codes. Codes that will not be imported are the 
Suspended and Withdrawn codes Z and W. 
Currently the codes available for Import are U, X, R, T, E, M, L, C, Y, N, V, Q, K and / (Present 
Code) 
 

<PeriodFrom> and <PeriodTo> Tags 

The data for the <PeriodFrom> and <PeriodTo> tags will be either AM or PM for a session half day 
absences or an integer for specific teaching period absences. 
 
If the <PeriodFrom> and <PeriodTo> text is for a period, i.e. an integer, then this will represent the 
first teaching or home period the absence is effective from. 
  
Periods defined in the Timetable period structure as U or B will not be counted in the period count. 
If the <PeriodFrom> data is 5, this would be equivalent to the period defined as the first afternoon 
period (t) as shown in Figure 13 below. 
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Each set of <PeriodFrom> and <PeriodTo> must be both sessional AM or PM or specific periods. 
 

A mixture of sessional and specific periods for one set of <PeriodFrom> and <PeriodTo> will not 
import that particular absence. For Example: 

 
<PeriodFrom>AM</PeriodFrom> 
<PeriodTo>7</PeriodTo> 
 

It will be possible to have sessional and period absence records for the same day such as: 
 

<Absence> 

<Date>2013-02-28</Date> 

<Periods> 

<Code>X<Code> 

<PeriodFrom>AM</PeriodFrom> 

<PeriodTo>AM</PeriodTo> 

</Periods> 

<Periods> 

<Code>L<Code> 

<PeriodFrom>5</PeriodFrom> 

<PeriodTo>5</PeriodTo> 

</Periods> 

</Absence> 

The value in the <PeriodTo> tag data must be later than the <PeriodFrom> tag. 

If an <Absence> tag contains more than one set of <Periods> tags, and there is any overlapping of 
<PeriodFrom> and <PeriodTo> information then the first set of <Periods> data will take 
precedence in that period overlap. 
 
For example the following <Absence> data in the XML file will result in the X code for periods 1 to 
5 then a U code for periods 6 to 10 in Integris Lesson Attendance day records. 
  

<Absence> 

<Date>2013-02-28</Date> 

<Periods> 

<Code>X<Code> 

<PeriodFrom>1</PeriodFrom> 

<PeriodTo>5</PeriodTo> 

<Periods> 

<Periods> 

<Code>U<Code> 

<PeriodFrom>3</PeriodFrom> 

<PeriodTo>10</PeriodTo> 

<Periods> 

</Absence> 
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With the example structure shown above, where all of the periods are set to teaching periods then 

the following absences import file structure would describe an absence of code ‘U’ for the periods: 

“Period 2”, “Period 3” and “Period 4”. 

 

<Absence> 

<Date>2012-11-29</Date> 

<Periods> 

<Code>U<Code> 

<PeriodFrom>4</PeriodFrom> 

<PeriodTo>4</PeriodTo> 

<Periods> 

<Periods> 

<Code>U<Code> 

<PeriodFrom>6</PeriodFrom> 

<PeriodTo>7</PeriodTo> 

<Periods> 

</Absence>. 

 

6.7.12 Create Daily Records 

If there is at least one record in the LAAbsences xml file with a date later than the earliest “Created 
Up To” date in the Lesson > Parameters > Create Daily Records window and that absence is not in 
the future, Daily Records are created for all Year Groups up to the latest absence date in the 
Import File, prior to the Import of data 
 
For example say the current date is 17th April 2013 and the school hasn’t created day records 
since the 11th April 2013, and the import file contains an absence with a date of 2013-04-17, then 
the message shown below appears. 
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If No is chosen the import will stop at this point and no absences are imported. Users may elect to 
go into Lesson Attendance > Parameters > Create Daily Records and manually create the day 
records up to the current date. 
 

 
 

If Yes is chosen then day records are created automatically for all year groups up to the latest 
absence in the LAAbsences import file. (Up to the 17th April 2013 in this example). 
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6.7.13 Import Log 

The standard XML Import log window opens once the Lesson Day records check is complete. 
The header section of this window shows details of the current Absences import file above a 
progress bar which moves across as the import progresses. 
 
The first line of the import log states the date and time of the start of the absences import, followed 
by the Import file details. 
 
The Import log shows details of absences being imported student by student, reporting any details 
of any day record changes where the existing record is not marked as present. 
 
Once the import is complete, the log can be printed or saved in the same way as a School to 
School Import. 
 

 
 

6.7.14 LAAbscencesImport.csv Log file 

Details of all of the attendance code changes, (where the original code isn’t a present code) are 
also saved in a LAAbscencesImport.csv file in the standard Integris Export folder as defined in   
Control > Preferences > Paths > Export Directory. 
 

 
 
  



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 6-46  

© 2020 Civica Education Pty Ltd  

 

The file header of the LAAbscencesImport.csv Log file contains details of the location of the xml 
import file and the Date and time of import. 
 
The following lines contain the details of the changes made to the student’s lesson day records, 
Student No., First name, Surname, Form, Year, Absence Date, Old Code, New Code, Periods and 
any Comments. 
 

 
 

6.7.15 LAAbscencesImportErrors.csv Log file 

Where the Import Routine finds exceptions in the LAAbsences XML import file, a log file 
LAAbsencesImportErrors.csv is generated.  
 
Examples of exceptions that exist in the Import XML file are: 
 

 Unable to find a student in Integris with the StudentRef in the XML import file.  

 Non-standard attendance codes, including those that have been set as inactive, for example,  
(F-Flexible). 

 Behaviour related suspended and withdrawn attendance codes Z or W, are either present in 
the Import File or exist in current data for a student on the same dates as absence data in the 
Import file. 

 Absences exist for periods outside of the number of teaching periods defined in Integris for that 
student for an absence date. 

 
For example if the LAAbscences import file contains an absence similar to below: 

<Date>2013-02-28</Date> 

<Periods> 

<Code>X<Code> 

<PeriodFrom>1</PeriodFrom> 

<PeriodTo>10</PeriodTo> 

<Periods> 
 
 

The student’s Lesson Attendance Day record has 8 teaching periods for this date, then the X Code 
is saved for the Periods 1 to 8 and the exception is reported for periods 9 and 10. 
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The file header contains details of the location of the xml import file and the Date and time of 
import. 
 
The following lines contain the details of exceptions found in the xml import file. This includes the 
Student Ref, First name, Surname, Form, Year, Absence Date, Code, Periods and the exception 
details. 
 
Where a matching student cannot be found in Integris the First name, Surname, Form and Year 
details are left blank. 
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6.8 Lates Follow Up 

Lesson Attendance > Absences > Lates Follow Up 

 
 
This functionality allows users the ability to follow up, by letter, those students with a Late code (L) 
for any period/s within a date range. The process is similar to the Absence Follow Up letter but for 
Lates.(See Section 6.1.) 
 

6.8.1 The Lates Follow Up Selection window 

Double Click on “Lates Follow Up”. This opens the “Lates Follow Up Selection” window: 
 

 
 
Select the date range to be followed up. Either enter ‘from’ and ‘to’ dates using the keyboard or use 
the Calendar buttons to locate the appropriate dates for tracking. See section 5.3.1 for details on 
using the Calendar. 
 
If “Check AM/PM sessions only” is checked, the system will only find those students with Lates for 
the AM or PM sessions, and ignore the individual periods. 
Check the AM/PM sessions only checkbox if required. 
 

 
 
On opening the Lates Follow Up Selection window, the default set of students is the whole school. 
Use the New Query button to select the student/s for absence follow up. This opens the standard 
Student Search window.  
Select students and click Find.  
To find all students click the Find button. 
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The set of students will be identified in the New Query field.  
 

  
 

 Click OK 
 
If no ‘Lates’data is available for the selected students the following message will display: 
 

 
 
If the Date range and Query are valid, and data exists for the selection, the Lates Follow Up 
window will open, displaying ‘Lates’ data for the selected students for the selected date range. 
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6.8.2 The Lates Follow Up window 

 
 

Example: To sort the data by the date the last letter was sent, click on the column header “Date of 

Last Letter”  
 
For the selected date range: 

1. The New column refers to the number of day records containing unresolved Lates that have 
occurred since the last letter was sent. 

2. The Followed Up column displays for each student the number of day records containing 
unresolved Lates for which letters have already been sent. 

3. The Total column indicates the number of total Lates (New and Followed Up) for each student, 
within the date range. 

 
There are further options available in the Lates Follow Up – Daily window: 

  
 

6.8.3 Viewing details of Lates 

Lesson Attendance > Absences > Lates Follow Up > Open Student View 

The ‘Open Student View’ function can be used to view the Lates for a selected student. This 
function is used for one student at a time. 
 

 Select a student for whom you wish to view more detailed records of the Lates displayed. 
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 Click on Open Student View . The Student View window opens, displaying the 
data:  
 

 
 

Note: Double-clicking on a student’s name in Lates Follow Up will also open the Student 
View window. 

 View or Edit the student’s data as required. 

 Click Exit to close the Student View window. 
 

6.8.4 Printing details of Lates that require follow-up 

Lesson Attendance > Absences > Lates Follow Up > Print Student View 

The ‘Print Student View’ function can be used to print a list of the Lates for a selected student. 
This function is used for one student at a time. 
 

 Select a student for whom you wish to view more detailed records of the Lates displayed. 
 

 
 

 Click on Print Student View .  

 Select the print option required and click OK.  
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The report shows the Lates in the selected date range that require follow-up.  
 

 
 

6.8.5 Viewing a student’s Letter History 

Lesson Attendance > Absences > Lates Follow Up > Letter History 

The Letter History function provides a summary of ‘Lates’ letters sent for selected students over a 
selected date range. 
 

 Select the student/s by highlighting their name/s on the list. The list can be sorted by clicking 
on column headers. To select several students press the <Ctrl> Key and click on students’ 

names on the list. To select all students on the list click the Select All . 
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 Click on Letter History . A message appears: 
 

 
 

 Click Yes to proceed. 

 Select the print option required and click OK. 
 
The Letter History Summary displays the following information: 
 

 
 
 
 
 
 
 

6.8.6 Producing a Follow-up Letter 

Integris provides a function to produce follow-up letters for a selection of students for selected 
dates. To produce a letter for one/more student/s: 
 

 Select the student/s by highlighting their name/s on the list. The list can be sorted by clicking 
on column headers. To select several students press the <Ctrl> Key and click on students’ 

names on the list. To select all students on the list click the Select All . 
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List of students sorted by New column to indicate students who have lates that have occurred 
since the last letter was sent. Students with new lates have been highlighted. 
 

 Press Follow-up Letter . 

 Press Yes to confirm that you wish to print the letters for the selected students.  
 

 
 

 Choose the Printer as the print destination, or the screen if you wish to view the letters on the 
screen prior to printing them. You will be asked to select the recipient/s from the following 
options: 

 

 
 

 Click the radio button for the recipient/s of your choice.  
 
You have the option of selecting either Letter 1 or Letter 2 (as set up in Lesson Attendance 
Parameters > Defaults > Lates Letter). Click on the appropriate radio box. At this point there is an 
option of editing the text in the body of the letter/s for the selected students.  
 

 Edit the text as required.  

 Click OK. 
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Note: If you are printing a letter that has already been sent on the current day, for a selected 
student, the following message will be displayed: 

 

Click Yes to print another letter or No to cancel the printing of the letter for that student. 
Clicking Cancel will result in the following message: 
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Note: If one/more of the students do not have a parent/guardian flagged for the selected 
letter destination, the following message will be displayed: 

 

In this example the user had chosen to send the letters to parent/guardian marked as the 
Family Mail Marker. 

 

Note: If printing letters for more than thirty students, the system will divide the printing of 
letters into batches. 

 

Click OK and the following message will be displayed. 

 

The system will automatically keep printing batches until all the selected students have had 
letters printed. 

 
The letters will be printed and the Date of Last Letter will be updated for the selected students in 
the Date of Last Letter. 

 Click Close. 
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Sample Lates letter for a student with a five period day period. Note that for a student with AM/PM 
attendance, there would be no period data. 
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6.9 Process Extra Students 

Lesson Attendance > Absences > Process Extra Students 

 
In the Day View window (in Registration mode only) there is a hyperlink style button to allow the 
teacher to record additional students who attend the class.  These students might otherwise be 
expected by the system to attend a different class, where they are likely to be marked absent. 
Extra Students recorded in this way can then be dealt with later by staff using the Process Extra 
Students function in the Absences Menu. 
 

 
 
Extra Students window 
 

 
 

Process Extra Students Window 

 
The Process Extra Students Window is available from the Absences Menu. 
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This will display a list of all ‘Extra Students’ that are currently recorded within a specified date 
range. 
 
This list can be sorted by clicking on the list headers. 
 
The list can be printed (as currently displayed) so that it can be used to assist in correcting 
student/set placements. 
 
The student’s current attendance mark for the period is displayed.  Where this is an absence code, 
this is likely to be because the teacher of the set where the student is due to be (according to the 
system) has marked the student as absent.   
 
The user can mark the student as present.  This will alter the student’s mark for the period, and will 
also alter the set and staff that they are due to be with.  It may also alter the AM or PM codes.  It 
will not alter the student/set link records - this will need to be completed via the Timetable 
functions. 
 
If a student is not expected to attend any lesson for the specified period, then this will be updated 
for this date only. 
 
The Extra Student records can also be deleted. 
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6.10 Student View  

Lesson Attendance > Absences > Student View 

The Student View window displays the attendance records for a given student covering a given 
date range.  
 
Student View is accessed by: 

 Clicking on the Absences icon in the Lesson Attendance sidebar and selecting Student 
View from the menu.  

 

 
 
The Student View window opens. 
 

  
 
 
 
Users have four options for displaying attendance data for a student. 
  

Key to attendance 
codes 
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Absences that require follow-up 

Select this option to display/edit only those records that include absence data to be resolved. This 
is the default selection on opening the Student View window. It is particularly useful for updating a 
student’s records when a note is received. 

All days with Absences and Lates 

Select this option to display all days (in the selected date range) on which the student was either  
absent or late. 

All Days with Lates. 

Select this option, with a certain date range, to view days a student was late. 

All Days 

This option will display all of the student’s attendance records for all the days in the selected date 
range. 
 

Viewing and entering data in Student View 

 Select the appropriate radio button for the data you wish to view. 
 

          
 

 Enter the date range for which you wish to view attendance data. See the section 5.3.2. 
Using the Select Date button on page 5-18 for details on selecting dates using the Select 

Date button.  
 

 
 

 Enter the student’s name in the Surname/Ref. No. field, using the options described in 
section   5.3.6 Loading data by individual student in Day View  
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 Press <Enter> or <Tab>. The attendance data will be displayed. The following screen shot 
shows a secondary student’s period structure.  

 

 
 

Note: When the period structure varies from day to day, the headings will reflect the 
headings for the first day of the attendance year, and days with differing structures will be 
marked with an asterisk.  Breaks will not be greyed in this case.  

 The window also displays a list of dates on which absence follow-up letters have been sent. The 
above view is for a secondary student. 
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Primary students’ data is displayed for morning and afternoon (AM/PM) sessions: 
 

 
 
To enter/update data, select a code from the Codes list and click in the appropriate cell to record 
the code. The business rule regarding the effect of changes to period codes on session codes and 
vice versa is the same as for the Day View window. See section 5.3.9 Adding and entering period 
attendance data on page 5-24. 

 Use the OK button to save the data. 

 Use the Cancel button to cancel any unsaved data that has been entered.  
 
Changes to am/pm codes have no effect on the period codes where the period codes are visible. 
The user has to make any changes to the period codes manually. 

Changing the date range 

If you need to load data for the same student for a different date range:  

 Enter the new ‘from’ date and press <Tab>. 

 Enter the new ‘to’ date and press <Tab>. 

 Press <Tab>to highlight the Update Records button.  

 Press <Enter>. 
 
The data for the selected date range will be displayed. 
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 Enter and save data as required. 

 Click Exit to close the window.  
 

6.10.1 Printing data from Student View 

Use the Print button to print data for a student over a selected date range.  

Figure 1 - Report showing unresolved absences for a primary school student for a selected 
date range. 

 

Figure 2 - Report showing all absences for a secondary school student for a selected date 
range. 

 

6.10.2 Adding and editing comments in Student View 

Comments relating to a student’s absence may be entered and edited via Student View. 
 

 
 
The Student View window has a check box for each student, each day. A tick in the check box 
indicates that a comment/note has been recorded for the day.   
 
To add/edit a comment:  
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 Click on the appropriate day’s check box  in the Comment column  to open a text 
entry window. 

 
 

 Enter the comment text. Press <Enter> to move to a new line in the comment.  
 

 
 

 Press <Tab> to activate the OK button.  

 Press <Enter> to save the comment and close the Comment window. 
 
If a comment has already been entered (e.g. the time the student arrived and/or the reason for an 
absence), it will appear in the comment window when opened in Student View. This comment may 
be edited. The following example shows a comment that has been entered via the Lates window.  

 Place the cursor after the comment to add additional information. 

 To delete a comment, highlight the text and press <Delete> or <Back Space>. 
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6.11 Unresolved Absences  

Lesson Attendance > Absences > Unresolved Absences 

The Unresolved Absences button will launch the Day View: Unresolved Absences window. This 
will allow the follow up of unresolved absences for a single date only and the window will default to 
the current date. The user can select students based on Form, Teaching Set or use the Student 
Find function. More than one student can be loaded into the window but they must all have the 
same Period Availability Structure.  
 

 
 
If a group of students is selected and none of them have any unresolved absences, then a 
message will be shown: 
 

 
 
If all Year Groups use the same Period Structure, then an additional radio button ('All Unresolved') 
will be available.  Selecting this option will search for all students with unresolved absences for the 
selected date. 
 
As with all Lesson Attendance windows, the user can choose to locate students with unresolved 
absences by Form; Teaching Set; Student find. Once the required set of students has been 
loaded, the user is able to edit the attendance data as necessary. 
 



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 6-67  

© 2020 Civica Education Pty Ltd  

 

 
 



 

 

 
 
 

7 

Reports 

7 

 

            Lesson Attendance Manual 



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 7-2  

© 2020 Civica Education Pty Ltd  

 

Reports 
 

 
 
A selection of Lesson Attendance Reports is available by selecting the Reports icon on the Lesson 
Attendance sidebar. For detail on producing individual lesson attendance reports please refer to 
the separate “Lesson Attendance Reports Manual.” 
 

7.1 Lesson Attendance Reports Window 

The Reports window opens to display the following list of folders: 
 

 
 

7.1.1 Attendance Forms 

The following reports are available in the Attendance Forms folder: 
 

 
 

Used in NT only 
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7.1.1.1 Error message in Attendance Forms 
In the Form/Year Absentee Report, if the range of data selected by the user is large and results in 
the generation of more than 375 absences to report, the following warning message is generated. 
 

 
 

7.1.2 Attendance Records 

The following reports are available in the Attendance Records folder: 

 
 

7.1.3 Analysis Reports 

The following reports are available in the Analysis Reports folder: 
 

 

7.1.4 Subject Attendance 

The following reports are available in the Subject Attendance folder: 
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7.1.5 Exports 

The following exports are available in the Exports folder: 
 

 
 

7.1.6 Custom Reports 

This folder is used to store user’s customised reports. 
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7.2 Evacuation Report 

This report prints a list of all absent students from the top toolbar. Click the  icon and the 
Evacuation Report window is displayed: 
 

 
 
The options available for this report are 

 Absent students by Form. 

 Absent students by Year. 

 Absent students by House. 

 All students by Form. 

 All students by Year. 

 All students by House. 
 

 
 
The Evacuation Report is available in three styles: 

 By Form – This which will print a year group on each page separated into form groups. 

 By Year – This will print the whole report on a page, sorted by year and then surname. 

 By House – This will print a house on each page with students alphabetically listed. 
 
This default selection on this report is controlled via Parameters > Defaults > System Management 
(See Section 8.6.4), although the default output can be overridden when the Evacuation Report is 
generated.
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8 Parameters 

 

8.1 Introducing Parameters 

 Click on the Parameters icon in the sidebar to display the Lesson Attendance Parameters 
screen. 

 

 
 
The Parameters section of Lesson Attendance provides access to Lesson Attendance setup and 
maintenance functionality. 
 

8.2 Attendance codes 

The software is set up with a standard set of codes and these should not be edited without contacting 
your Support Centre. Once codes are used for recording, they become fixed and cannot be edited. 
 
At the point of creation of a New Year in version 2.45 onwards, a new Attendance Code will be added 
to Codes List with letter “Y” (Refer to section 3.2). 
 
The records will contain the following values: 

 Code letter = “Y” 

 Code Type = “Not counted in Attendance” 

 Code Description = “Enforced Closure” 

 Resolved Status = yes 
 
Please refer to section 8.3 for further details. 
 

8.2.1 To add/edit/delete attendance codes  

 
To add/edit/delete attendance codes:  

 Click on the Parameters icon in the sidebar.  
 

 Click on Attendance Codes  in the Parameters window. The Attendance 
Codes window is displayed. (The window shows the attendance codes that have been set 
up for use in a DoE WA school.) 
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A list of attendance codes can be printed using the Print Attendance Codes button  at the top 
of the screen. Follow the standard procedure to print a report. 
 

WA Notes: From 2013 the Attendance Code X will have a Resolved Status of “Yes”. 

The F Code (Flexible) will be inactive once a new attendance Year for 2013 is created for 
DoE WA schools. It will still appear in Reports and in the lists of Attendance Codes. 

From 2014 the F Code will be followed by the text (Code no longer active) in the Parameter 
window. 

Codes Q (Study Leave Year 11 and 12 ony) and K (Unauthorised Vacation) have been added 
to the available codes. 

 
  

Resolved Status: identify the status 
as Resolved or Unresolved. This 
will assist in Absence Follow Up.  

Report Appearance: only codes that are numbered will appear in Lesson 
Attendance reports. There is space on the Lesson Attendance reports for three 
‘Unauthorised’, six ‘Authorised’ and three ‘Approved’ codes. 
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8.2.2 Adding an attendance code 

Before you decide to add an attendance code, consider carefully the effects this will have on your 
school’s data. It is strongly recommended that you contact your Support Centre before adding codes. 
 
To add an attendance code 

 Click on the Add Attendance Code button  at the top of the Attendance Codes window. 
The Add Attendance Code window will open. 

 

 
 

 Enter the data for the new code in each field. <Tab> between fields. 
 

 
 

 Code: enter a unique attendance code  

 Description: up to 35 characters in length 

 Type: identify the absence type as Unauthorised, Authorised, Approved or Late. 

 Resolved Status: identify the status as Resolved or Unresolved. This will assist in Absence 
Follow Up.  

 Report Appearance: only codes that are numbered will appear in Lesson Attendance reports. 
There is space on the Lesson Attendance reports for three unauthorised, two authorised and 
three approved codes. 

 Click OK to save the new attendance code.  
 

Note: you will not be able to delete the attendance code once Lesson Attendance data has 
been entered in the system 

 

8.2.3 Editing Attendance Codes 
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Once Attendance Codes have been set up in the software you will be able to edit only the 
Description and Report Appearance fields. This limitation on editing is to ensure data is valid. It is 
strongly recommended that you contact your Support Centre before editing codes. 
 
To edit Attendance Codes (Description and/or Report Appearance) 

 Open the Attendance Codes window in Lesson Attendance sidebar > Parameters > 
Attendance Codes. 

 Click on the Attendance Code you wish to edit. This will highlight the code. 

 Click on the Edit Attendance Code button  at the top of the window. The Edit 
Attendance Code window is displayed. 

 

 
 

 Edit fields as required. 

 Use the OK button to save editing. The edited attendance code now appears in the 
Attendance Codes window.  

 Use the Close button to close the Attendance Codes window. 
 

8.3 Enforced School Closure: The “Y” Code  

From Lesson Attendance 2.45 onwards a new attendance code is now available in Lesson 
Attendance. This special “Y” code can be assigned to students when the school, or part of the school, 
has had to close. Students assigned this code are not counted in Attendance. In effect the code is 
similar to a school closed code (as found in the School Diary). The student is not present, but neither 
are they counted as absent. 
 

Note: The new code will be assigned the letter “Y”. For this reason it is essential that you 
do not have a code assigned that letter already in the system prior to upgrading to Lesson 
2.45. If you do, delete this code before creating a new Attendance Year. 

Please contact your Support Provider for further information. 
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8.3.1 Enforced School Closure Utility 

Properties of the “Y” code 

The “Y” code can only be assigned to students in the utility: Lesson Attendance>Parameters > 
Enforced School Closure. 
 

 
 
To ensure that it cannot be used in any other way, the following will apply: 
 

1. You cannot edit or delete in Parameters > Attendance Codes 
2. You cannot map the code in Parameters > Map Attendance Codes 
3. The code is not accessible in  Parameters > Defaults 
4. The Code does not appear in Day View, Week View or Student View. 
5. The Code does not appear in the Speed Entry or Lates. 
 

8.3.2 The Enforced School Closure window 

The Enforced School Closure function can only be accessed by one user at a time. Should another 
user attempt to use this function whilst it is already in use, the following warning message will 
appear. 
 

 
 
When you double click the Enforced School Closure item, the School Closure window will open: 
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8.3.3  Appling the School Closure using Student Find 

 
Before beginning the following checks are made: 
 

 The date must be within the current attendance year 

 The school must be open for that date. 

If you select “Student Find” then you can select one or more students either by selecting a query or 
by clicking on the New Query button.  

When you close the School, then, for selected students: 
 

 Those that already have the Y code will retain the Y code 

 Any student already marked with an authorised or approved absence code will not have 
the code overwritten 

 Those with any other attendance code should be changed to the Y code 

 The ‘Reason for Change’ text will be saved as note for that particular day 

To close the school for students: 

 Select the date, and chose whether the closure is Whole Day or AM or PM. 

  A reason for the change must be added 
 



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 8-8  

© 2020 Civica Education Pty Ltd  

 

 

 Click Apply School Closure 
 
The following message will be displayed: 
 

 
 

 Click Yes to continue and the records will be processed: 
 

 
 
On completion the following message will be displayed. 
 

 
 

 Click OK  

 Click Exit 
 
If the user cancels the School Closure: 
 

 Those students marked with the Y code will be marked with the default code set by the 
school (most schools mark this as present, but some mark it as absent); 

 Other students’ attendance codes will remain unaltered. 
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8.3.4 Appling the School Closure for the Whole School 

 
All students will be assigned the “Y” code; irrespective of any code they might have already been 
assigned.  
 

 Select the date, and chose whether the closure is Whole Day or AM or PM. 

 A reason for the change can also be added: 
 

 
 

 Click Apply School Closure 
 
The following Warning will be displayed: 
 

 
 

 Click Yes to continue 
 
The records will be processed and a message similar to that shown below will be displayed: 
 

 
 
Once completed the following message will be displayed: 
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 Click OK to continue. 

 Click Exit 
 

8.3.5 Impact of the “Y” code on other areas 

View Screens – Day View, Week View, Student View: 
 The “Y” code in the AM/PM or Periods sections cannot be overwritten, nor does it appear in 
the Codes list. 
 
Speed Entry: 
 If there is a “Y” code in EITHER the AM or the PM session, no changes can be made.  
 
Lates: 
 If the Relevant Session is “Y”, no changes will be made.  
 
Registration: 
 The “Y” code in the AM/PM or Periods sections cannot be overwritten, nor does it appear in 
the Codes list. 
 
Impact of multi user access may be 
 

 Other users could possibly create or make changes to Lesson Attendance student day 
records whilst the process is running. 

 In the current module if this were to happen the other user would get an issues list as 
shown below or if the other user has already made a change this will be over-written with 
the Y code change, as shown below in Error! Reference source not found. and Error! Re
ference source not found.. 

 

Day View multi-user change 
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Week View multi-user change 

 

 
 



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 8-12  

© 2020 Civica Education Pty Ltd  

 

8.4 Create Daily Records 

Create Daily Records is dealt with fully in section 4 

8.5 Create New Attendance Year  

Create New Attendance Year is dealt with fully in section 3.2 

8.6 Defaults 

8.6.1 Defaults Tab 

The Defaults tab section of Lesson Attendance Parameters allows users to create/select various 
default settings in the Lesson Attendance module. The following window is accessed via Lesson 
Attendance sidebar > Parameters > Defaults. 
 

 

 Click on the Edit button to edit any of the default settings .  
 
In the Lesson Attendance options window in the ‘Defaults tab ‘the user can set the following 
parameters: 

Default absence codes for the Lates, Speed Entry, Day View, Student View and Week View 
windows 

 The default absence code for the Lates window is the code that will be displayed when the 
Lates window opens. It can be overwritten in the Lates window when entering data. 

 The default absence code for the Speed Entry, Day View, Student View and Week View 
windows is the code that will be displayed when the windows open. It can be overwritten in 
each of the windows when entering data. The default codes can be changed in Defaults if 
users find they enter another code more frequently than the ‘U’. 

Home periods count towards absence rules 

Users can decide whether home periods count towards absentee statistics. This is provided to allow 
schools to exclude home/registration periods from those periods being used to determine am/pm 
attendance.  
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If your school has a home period and it has been set to count towards absentee statistics when 
creating a new attendance year, the check box will be ticked.  To uncheck this field, and exclude the 

home period in absentee statistics, click on the Edit button  and uncheck the field. 

 
 
If you have selected for specific periods to be linked to the AM and PM codes (in the Year Groups 
window) then setting this value will be irrelevant for those year groups. 

Setting minimum percentage attendance 

Set the percentage of periods that a student should attend in a session to be regarded as present 
for each AM/PM session. For example, if students should attend for a minimum of three of four 
morning periods (or three of four afternoon periods) in order to be counted as attending the session, 
set the Minimum percentage attendance required per session to 75%. 

 
 

Note: If less than or equal to the set percentage of periods are marked as present, the first 
attendance code (other than present code or late code) will be used as the attendance code 
for the session. 

Examples of threshold percentage settings 

 
 
 
 
 
 
 

 Click on Edit  to edit the minimum percentage required per session. 

Example 1 – if the threshold is set at 65% then the student will need to attend as 
follows to be marked as present for a session: 
 

Total Periods 1 2 3 4 5 6 7 8 

Minimum to 
count as 
present for 
session 

1 2 2 3 4 4 5 6 

 
Example 2 - if the threshold is set at 75% then the student will need to attend as 
follows to be marked as present for a session: 
 

Total Periods 1 2 3 4 5 6 7 8 

Minimum to 
count as 
present for 
session 

1 2 3 3 4 5 6 6 
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If you have selected specific periods to be linked to the AM and PM codes (in the Year Groups 
window) then setting this value will be irrelevant for those year groups. 
 

Setting Daily Record Management Mode 

This function allows users to determine the mode of creating daily records. 
 
There are three settings: 

 Automatic. 

 Manual. 

 Off. 
 

 

Automatic Daily Record Management 

This setting provides a function whereby when Speed Entry is exited and there are just a day’s 
records to create, the creation of the records will occur automatically. 
 
Manual Daily Record Management 
Where the mode is set to Manual, when the user exits Speed Entry, the Daily Records window will 
be displayed so the user can create the necessary daily records. 
 
Off Mode 
When the Daily Record Management mode is set to “Off”, the Daily Records can only be created 
from Parameters > Create Daily Records. 
 

8.6.2 Defaults Absence Letter Tab 

Integris provides a standard absence letter (that can be edited) and the option to set up a second 
letter. When printing follow-up letters, users will be asked which of the two letters they wish to use: 
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Letterhead and school logo can be set up in the General Sidebar > Control > Preferences > 
reports. See the Administration Manager Manual for more information. 
 
Schools can edit the text to appear in the body of the letter as shown below: 
  

   

 Click on Edit . 

 Add/Edit the text of Absence Letter 1 if required. 

 Add/Edit text to Absence Letter 2 if required. 

 Click OK. 
 

Note: Changing the Absence letter text (the text in the body of the letter) will change the text 
for both user-defined and form letters.(See Section 8.6.6) 

 

 

Search for students with these Unresolved Absences 

Users can select either a single unauthorised code to report on, or “All Unresolved Codes”. 
The Absence Follow up Letter will contain the absences based on the option selected. 

 

 Click on Edit . 

 Select from option from drop down list. 

 Click OK. 
 

8.6.3 Defaults Report Instructions Tab  
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One of the Lesson Attendance reports, the Morning Absentee Report, has a field that enables 
users to enter text in an Instructions field at the top of the report. Enter any instructions required or 
leave blank.  

 
 

 Click on Edit . 

 Add/Edit the text as required 

 Click OK. 
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8.6.4 Defaults – System Management 

  

System Management Switch 

System Management can be switched on or off.  This will control whether the taking of registers is 
logged via the Registration option. (This is only applicable to TIME or TIMETABLE users). 
 

WA Note: For DoE WA schools, The System Management On and Track Attendance 
Changes check boxes will default to be ticked from Version 2.84 onwards. In Edit Mode (as 
shown below), they cannot be changed. 
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AM/PM code clicks 

There are three options that control direct changes to AM/PM codes in Day View and Student View 
windows: 

 No Confirmation Required – Users will be able to change AM/PM codes freely. 

 Confirmation Required – Users will be asked to confirm changes to AM/PM codes. 

 No Changes Allowed – Users (other than Administrator users) will not be able to change 
AM/PM codes. 

Default Attendance Code 

A default Attendance Code must be selected from the drop down list of approved codes. The 
default should be set to / present although it is possible to alter this. 

Note: Department of Education and Training (WA) schools should use the default code 
Present /. 

Sensible alternatives would be 'U' for unauthorised absence, or you could create another 
unauthorised absence code (such as '?'). Using a default other than / present, will mean that 
saving the register will take longer. 
  

Day View Right Clicks 

By default use of the right mouse click in the Day View window will update the selected period and 
all remaining periods in the day which are after the selected period.  The administrator can now 
elect to restrict the use of this right click function.  The options are: 
 

Enable Right Clicks in Day View The right mouse click will update remaining periods in 
the day (default mode) 

Disable Right Clicks in Registration 
Mode  

The right mouse click will work in the Day View window 
except when the Day View window has been opened via 
the Registration icon. 

Disable Right Clicks in All Day View 
modes 

The right mouse click will not operate in the Day View 
window however it is opened. 

 

Evacuation Report Type 

The Evacuation Report is available in three styles: 

 By Form – This which will print a year group on each page separated into form groups. 

 By Year – This will print the whole report on a page, sorted by year and then surname. 

 By House – This will print a house on each page with students alphabetically listed. 
 
The default output as selected in the Evacuation Report Type below can be overridden when the 
Evacuation Report is generated (See section 7.2). 
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Track Attendance Changes 

This enables detailed logging of changes made to the AM and PM codes for student attendance 
records. This function is described in detail later in this section.  
Lesson Attendance now provides the functionality to track changes made to the AM and/or PM 
session for students. This option is available through Lesson Attendance >Parameters > Defaults > 
System Management. 
 

  
 
When a user changes an AM or PM code for a student record there is a requirement is some 
schools to record the fact. This is accomplished in two ways: 

 An extra two fields in Student Day records store the last 20 codes (in reverse order) that 
have been recorded for the day. This happens automatically 

 An extra database file logs changes. This recording has to be switched on in Parameters > 
Defaults > System Management by selecting the Track Attendance Changes option. 

The second of these options logs changes where there is already data in the history field and the 
old code is not the default code or where the change is being made on a date other than the date 
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of the Student attendance record. The Attendance Corrections report in Reports > Attendance 
Records will report on the changes recorded in the second step. 

Day View – Place students located via Student Find to the top of the list 

By default the ‘Day View – Place students located via Student Find to the top of the list’ option will 
be un – ticked. When un-ticked the Day View window will always sort students alphabetically. 
When you check the box thus choosing the option to place the found student/s to the top of the list 
the following changes will be apparent within Day View.  
Choose the Student Find selection option in Lesson attendance >Day view , as shown below, 
students selected either through typing name / reference number into the entry field, or through 
use of the Student Find Tool, will be added to the top of any existing student selection, rather than 
being added in alphabetical order. 
 

 

 
 

To Track Changes/Corrections 

With the Track Attendance Changes checked in the System Management window, the school will 
be able to generate reports detailing changes to students attendance data, such as updating 
information after receiving notifications from Parents/Caregivers regarding a student’s absence 
from school. 
 

 Ensure Tracking Attendance Changes is checked in System Management 

 
 Record changes to student data using the most appropriate method, e.g. Student View 
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 Go to Lesson Attendance > Reports > Attendance Records > Attendance Corrections 

 
 

 
 

Default Registration Times 

Note: Department of Education and Training (WA) schools will not use this option. 

Where Timetabling is not chosen as an option for a year group, it will be possible to specify start 
and end times for the AM & PM registration periods.  These will help to set the current period on 
the Registration windows.  This functionality is not currently available. 
 

8.6.5 Lates Letter 
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Integris provides a standard Lates letter (that can be edited) and the option to set up a second 
letter. When printing follow-up letters, users will be asked which of the two letters they wish to use: 
 

 
 
Letterhead and school logo can be set up in the General Sidebar > Control > Preferences > 
reports. See the Administration Manager Manual for more information. 
 
Schools can edit the text to appear in the body of the letter as shown below:  

   
 

 Click on Edit . 

 Add/Edit the text of Absence Letter 1 if required. 

 Add/Edit text to Absence Letter 2 if required. 

 Click OK to save the changes. Click Cancel to cancel the changes. Click Exit to close the 
window. 

 

8.6.6 Letter Defaults 

These defaults apply for the Unresolved Absences and Unresolved Lates 
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If the ‘Form Teacher’ (Class Teacher) is selected as the signatory, each student’s letter will print 
the name of his or her form teacher. 

 

 

User-defined signatory 

 To change the sender’s name/position to another name/position 

 Click Edit   

 Check the User defined radio button. 

 
 

 Enter the Name and Position of the sender. 

 
 

 Edit the text for one or both the absence letters, if appropriate.  
 

 Click OK to save the changes. Click Cancel to cancel the changes. Click Exit to close the 
window. 

 
The Letter Recipient option will initially default to 'Send letters to all marked as family mail 
marker'. The full range of options includes: 
 
Send letters to all marked as family mail marker  
Send letters to all marked as having Parental Responsibility 
Send letters to Parent/Guardian 1 only 
Send letters to the Parent/Guardian of ….. 
 
The first of these options is suitable where the datafile does not contain full details of students’ 
contacts. 
 
When printing Absence follow-up letters the ‘Select Letter’ destination will default to the ‘Letter 
Recipient’ which has been set in Lesson Attendance Options > Absence Letters. 
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The following example shows the layout of a printed user-defined letter for a secondary school 
student with 5 timetabling periods. For a student with am/pm attendance (e.g. primary school 
students) the letter displays am/pm absence codes. 
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Pre-printed stationary letterhead option. 

Some schools use their own headed stationary. An option to allow you to choose between using 
the school letterhead stationery or the default letterhead printed by the system is provided via a 
checkbox. 

 Click into the checkbox if required. 
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8.7 Delete Old Attendance Data 

This function allows the user to delete an entire year’s attendance data. If this function is chosen it 
will delete the period availability structures, year groups and all attendance records for the year 
that the user has chosen to delete. It is recommended that a Common Export report be created 
prior to completing this action.  

Note: This function should only be carried out by a user with Administrator status as an 
Administrator password is required to complete this function. 

 
The Delete Old Attendance Data function is accessed through Lesson Attendance > Parameters.  
 

 
 

 Double click on the Delete Old Attendance Data in the Parameters window. 

 The following screen will appear: It will default to the current Year settings. 
 

 
 

 Click on the down arrow to choose the Year to Delete. 
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 Once the Year to Delete has been selected The Start of Attendance Year field will be 
updated as well. 

 

 
 

 Choose the radio button to determine the data range that is to be deleted. 
 

 
 

 Once all options on this screen have been set, click on OK to proceed with the deletion.  
The Administrator Password will need to be entered to proceed any further. 

 

 
 

 A warning message will appear giving the user the option to continue or not. Clicking on No 
will cancel the Warning message and take the user back to the original screen 

 

 
 

 Clicking on Yes will generate the next Warning message. 
 

 
 

 Clicking on Yes will close the Warning message to allow the user to update the attendance 
history and create the attendance export file. 

 Clicking on No will start the deletion process. 
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 Once the process has been completed click Ok to close the window. 
 

 
 

8.8 Delete Student Day Records 

Delete Student Day Records will remove all attendance data for the date range and students 
selected.  
 

 
 
The Delete Student Day Records utility is accessed through Lesson Attendance > Parameters.  

Note: Once deleted, the Attendance Data cannot be retrieved so caution and advice should 
be taken before running this Utility. 

To Delete Student Day Records: 
 

 Double Click on the Delete Student Day Records option 

 Select the Date Range to delete records 
 

 
 

 Click on New Query to select the students to delete the records from 
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 Click OK to Process 

 View the Warning Message 
 

 
 

 Click Yes to confirm the deletion of the records 
 

 
 

 Click OK.  
 
The system deletes the records and provides a record of the deletions in Control > Audit > Activity 
Log window. The students’ Reference Numbers are listed. 
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Records can be recreated using Speed Entry or Creating Daily Records. 
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8.9 Map Attendance Codes  

 
This functionality allows changes to be made to lesson attendance code.  
 
Users will not be able to change the code directly, as it could affect historic data. Instead a code-
mapping window, where you can map all occurrences of one code to a different code, within a 
given School Year is provided. 
 
This utility appears in the Parameters section, and opens the Map Attendance Codes window. 

 

8.9.1  Map Attendance Codes window 

 
 

The window is only available in Single User mode. The “Present” code does not appear. 

 
 

8.9.2 Mapping the Code 

This process is not necessarily completely reversible: If you have students with “X” codes, and 
students with “T” codes already in the system, and you map all “X’s” to “T”, you will no longer be 
able to distinguish between the original “Ts” and the new ones.  
For this reason, make sure you are mapping only the codes that need changing.  

 

 Select a “from” and a “to” code and select an academic Year.  

 Click on “Map Codes” 

 All occurrences of the “from” code in the records for the selected Year will be 

changed to the “to” code. 

 You can only change codes which have the same Type. 
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Note: The later into the Academic Year that you do this, the longer the process will take, as 
there will be many thousands of Attendance records to examine. 

 

8.10 Period Availability Structure 

See section 3-11 Setting up the Period Availability Structure 
 

8.11 Timetable Cycle Start Dates 

See section 3.3 Setting up Timetable Cycles 
 

8.12 Year Groups  

An icon on the Parameters > Year Groups window enables users to add a year group to Lesson 
Attendance after the year has started.  This is useful where you are implementing Lesson 
Attendance as a gradual process, one year group at a time. 

 
 

8.12.1 Adding a Year Group Using Lesson Attendance 

It is possible to add a year group to Lesson Attendance after the new lesson attendance year has 
been created. Only those Year Groups that do not currently appear in Lesson Attendance can be 
added to the year groups. 
 

 Click on the Add  button to open the window to add a new year group. From the Year 
Group drop down choose the required Year. The Start Attendance date field will default to 
the current date; this can be edited, if required. The required Period Structure is then 
chosen from the drop down list. 

 

Add a Year 
Group 
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Note: If the Period Structure required is not available from the list, it must first be created in 
the Period Availability Structure Parameter. 

 Upon clicking on OK to confirm the new Year Group a warning message will be generated. 
Yes will create the new Year Group and No will cancel the process. 
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8.12.2 Changing Period Structure linked to a Year Group 

It is possible to change the period structure that a year group is linked to during an attendance 
year. This can only be done by a user with Administrator status as the Administrator’s password is 
required to complete this function   
 
Linking a new period structure should not be done unless all attendance data is up to date and 
daily records have not been created for future dates.  Be aware that any changes to period 
structures may invalidate some of the Lesson Attendance reports that cover the period before and 
after the change. 
 
It is not possible to alter a Period Structure during the year, but it is possible to add new period 
structures.  
 
To change the Period Structure for a Year Group, go to Parameters > Year Groups 

 Click on Edit Pencil  at the top of the Year Groups window. The Period Structure drop 
down list is now available to choose an existing structure. 

 

 
 

 Once the required period structure has been selected, clicking on the Save button will 
generate the Change Year Structure window ready for the Administrator’s password. Enter 
the password and click on OK to save the changes 

 

 
 
Daily records can now be created for all year groups, including the new year group in the usual 
manner. 
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Note: For TIME and TIMETABLE users, linking the Year Group to the Timetabling Option 
must be done to allow daily records to be created at the teaching set level.  Attendance can 
then be analysed at the teaching set level using the Subject Attendance reports in Lesson 
Attendance > Reports > Subject Attendance. 
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8.13 Palm Setup 

8.13.1 Enabling Palm Setup 

Before any users can be registered for Palm lesson attendance recording, the system must be 
enabled. This can be done on the ‘Lesson > Parameters > Defaults’ screen by selecting the 
‘System Management’ tab and checking the ‘Enable Palm Recording’ option. This will register new 
users for Palm lesson attendance recording. 
 
By un-setting this option you can prevent all registered Palm lesson attendance users from 
synchronising their data with the Integris data file. 
 

 
 

8.13.2  Registering Palm Lesson Attendance Users  

Once the system is enabled, you will be able to register new Palm lesson attendance users. This 
can be done using the ‘Lesson > Parameters > Palm Setup’ screen shown below. 

 
 
This screen show the registrations currently defined for use with Palm Lesson Attendance and 
allows you to add, edit or delete any of the registration details. 
 



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 8-37  

© 2020 Civica Education Pty Ltd  

 

To add a registration, click on the ‘Register New Palm’ button. To edit an existing registration, 
select the registration from the list and click on the ‘Edit Palm Registration’ button to bring up the 
following screen: 
 

 
 
Each Palm registration consists of a ‘Palm Username’, a ‘Registration Type’ and the ‘Registration 
Details’. In addition to this, there are several options you can set for each registration on the 
system. 
 
The ‘Palm Username’ is the name the Palm device uses when synchronising. This should match 
with the name shown at the top right hand corner of the HotSync screen on the corresponding 
Palm device. 
 
The ‘Registration Type can be either ‘Staff’, ‘Room’ or ‘Cover’ and the ‘Registration Details’ will be 
the specific Integris staff member or room or the selection of classes/teaching sets in the case of 
‘Cover’. Use the magnifying glass next to the registration type you choose to supply the registration 
details. 
 
If you select the ‘Reset at Next Sync’ option for a registration then the next time that Palm device is 
synchronised, any changes made on the Palm device will be discarded and a fresh set of data will 
be transferred to the Palm device. 
 
The ‘Suspend Registration’ option allows you to stop specific Palm devices from synchronising 
their data with Integris. i.e. A Palm device with this option set will not be able to update Integris or 
get any new data from Integris. 
 

8.13.3 Troubleshooting  

There are several areas which can be examined within Integris and elsewhere to make sure that 
the synchronisation processes are operating correctly. At the Integris end, any problems 
encountered during the synchronisation will be reported to the Integris audit log accessed through 
‘General > Control > Audit’. 
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During the synchronisation process, before and after the data has been processed by Integris, any 
problems encountered will be reported in the Hotsync log. Any general feedback will be reported in 
the desktop Hotsync log and any user specific feedback will be reported in the Hotsync log on the 
Palm device. 
 

                      
 

 
 

8.13.4 Palm Lesson Attendance Application 

 

Starting the application 

The Palm application can be started by tapping the ‘Lesson’ icon from the main screen. 
The application will then check that there is enough data present on the Palm to run the application 
correctly. If not, a warning will be displayed and you will have to perform a successful 
synchronisation before you can use the application. 
If the correct data is available on the Palm, the application will check the current time on the 
handheld and compare this against the timetable data. It will then try and load the data for the 
correct period of the day based on this time. If the application cannot determine the period, it will 
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load data for the first period it has available for the day. 
 

 
Recording Attendance 
 
When the application loads, you will be presented with the main attendance recording screen. This 
screen displays all the student data available on the Palm device for the date and period displayed 
in the title bar of the screen. The group name is displayed at the top right of the screen. 
 
You can navigate through the group by using the ‘Back’ and ‘Next’ buttons at the bottom right of the 
screen. Your current position in the group is also displayed at the bottom of the screen. 
 
The current attendance code for each student is displayed to the right of their name. If the student 
has been marked with an unauthorised absence code at any point during the day their name will be 
highlighted in red and a ‘(U)’ will be displayed to the right of their name. If they have been marked 
with a late code at any point during the day, their name will be highlighted in green and a ‘(L)’ will be 
displayed after their name. 
 
You can mark the default codes by checking and un-checking the check box next to each student 
name. To enter a reason code other than the default codes, you can use the dropdown list to the 
right of the student name. 
 
At the far right of the screen next to each student name is an indication of whether any notes have 
been entered against the student. A blue ‘*’ indicates they have notes entered and a yellow ‘-‘ 
indicates that no notes have been entered. You can click on this indicator to enter notes for the 
corresponding student 
 
Tapping on the title bar will open the menu allowing you to access other areas of the application and 
the ‘History’ button to the bottom left of the main screen will take you to the history screen . 
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Taking Notes 
 

 
The notes screen is accessed via the notes indicator on the main screen or via the notes indicator 
on the history screen. 
 
This screen allows you to view any existing notes for the student and add or edit your notes for the 
student. 
 
The top box on this screen displays any notes which were present in Integris at the point of the last 
synchronisation. These notes are read-only. 
 
The bottom box on this screen allows you to enter additional notes for the student. You can edit 
these notes until the next synchronisation is performed at which point they will be appended to the 
Integris note and will become read-only on the Palm. 
 
Notes can be entered using the Palm graffiti language, the popup keyboard which can be accessed 
by tapping the bottom left corner of the text entry section on the Palm or by tapping on the title bar 
of the notes screen to open the menu and selecting the ‘Keyboard’ option. 
 
You also have the ability to ‘Cut’, ‘Copy’ or ‘Paste’ notes from one student to another by selecting 
the appropriate text in the ‘Your Notes’ box, tapping on the title bar to open the menu and selecting 
the required option. 
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Changing Group 

 
The change group screen is accessed by tapping the title bar on the main screen and selecting the 
‘Change Group’ option. 
 
This screen shows the timetable details which are currently available on the Palm. This consists of 
period number, class/set indicator, group name and period times. 
 
To change the group displayed on the main screen, select the group for which you wish to enter 
attendance data and the tap the ‘Display Group’ button. You will then be returned to the main screen 
which will be populated with data for the selected group. 
 
To return to the main screen without changing group, you can tap the ‘Back’ button. 
 
Codes 

 
The codes screen can be accessed from the main screen by tapping the title bar to open the menu 
and selecting the ‘View Codes’ option or from the history screen by tapping on the title bar to open 
the menu and selecting the ‘View Codes’ option. 
 
This screen displays a list of all the attendance reason codes which are available on the Palm along 
with the code descriptions. 
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You can also view or change the default codes used when recording attendance (See 2.2). To 
change the codes use the dropdown list next to the code you wish to change, either ‘Default 
Checked’ or ‘Default Unchecked’. 
 
Attendance History 
 

 
The history screen can be accessed from the main screen by tapping the title bar to open the menu 
and selecting the ‘View History’ option or by tapping the ‘History’ button at the bottom of the main 
screen. 
 
This screen displays a list of all students in the current group (the one displayed on the main screen) 
who have been marked unauthorised absent or late at any point during the day. The attendance 
codes for the full day are shown for these students with the unauthorised absent codes highlighted 
in red and the late codes highlighted in green. 
 
The up/down arrows at the bottom left of the screen can be used to move through the list of students 
and an indication of your current position within the group is displayed at the bottom of the screen. 
 
You can tap on the notes indicator to the left of each student name to view or edit any notes attached 
to the student. 
 
To get a more detailed description of any of the codes displayed, tap the title bar of the screen to 
open the menu and select the ‘View Codes’ option to open the codes screen. 
 
Options 
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The options screen can be accessed from the main screen by tapping the title bar to open the 
menu and then selecting ‘Options’. 
 
You can use this screen to control what happens when you next try to synchronise the lesson 
attendance data held on the Palm with Integris. 
 
The ‘Full Sync’ option is the default and will update Integris with the data on your Palm and vice-
versa. 
 
The ‘No Sync’ option will prevent any lesson attendance data from being transferred to Integris and 
will also prevent the Palm from being updated by Integris. 
 
The ‘Reset Palm Data’ option will result in the loss of any changes you have made on your Palm 
since you last synchronised and will update the Palm with a fresh set of data from Integris. This 
option will be reset to ‘Full Sync’ the next time you synchronise. 
 
NOTE: Only set this option if you are prepared to lose any changes you have made on your Palm 
since the last synchronisation. 
 
Help 

 
 
Each screen within the application has associated help text which describes each function which 
can be performed on the screen. 
 
The help text can be accessed by tapping on the title bar of a screen to open the menu, selecting 
the ‘Help’ menu and then choosing the ‘Tips’ option from the menu. 
 
The ‘Help’ menu on the main screen also contains an ‘About’ option which gives general 
application information.  
 

8.13.5 Tips 
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Menu Shortcuts 
Each menu item in the application has an associated shortcut letter. To use shortcuts within the 
application, use the stylus to draw a diagonal stoke in the text entry section of the Palm screen 
from bottom left to top right. Then, use the Palm graffiti language to enter the symbol for the 
shortcut letter. This will activate the associated function. 
 

OMNIS Server 

 
Changing Data File 
If the Integris data file needs to be changed for any reason, the OMNIS Server software must also 
be pointed at the new data file. This can be done using the ‘Integris Web’ menu and selecting the 
‘Change Data File’ option. Once changed, the OMNIS Server software will automatically try to 
connect to the data file the next time it is started. 
 
Integris Single User Operations (Including Backup) 
The OMNIS Server software required for the Palm lesson attendance synchronisation maintains a 
link to the Integris data file. In order to perform certain Integris single user functions or copy the 
Integris data files for the purpose of making a backup, the OMNIS Server software will have to be 
stopped before the task is performed. The OMNIS Server software must then be re-started to 
continue using Palm lesson attendance. 
 
Known Issues 
Due to the size limitation of the Palm device screen, the History section of the application will only 
display the daily attendance record for students up to fourteen periods though the attendance 
recording section of the software can support the full sixteen period structures available in Integris. 
 
Palm Lesson Attendance > Name Display 
Due to the screen size and fonts used by the Palm device, students with long names will have their 
name truncated slightly. In rare circumstances, this truncation is still insufficient and the name can 
be split over multiple lines making it hard to read. 
 
Palm m130 and Portsmith Ethernet Cradles 
The Palm device model m130 requires and upgrade which RM can arrange to enable it to be used 
with the Portsmith Ethernet cradles for network synchronisation.  
 
  



 IntegrisLessonAttendanceManual 06-Apr-20  

Page 8-45  

© 2020 Civica Education Pty Ltd  

 

8.14 Using the Lesson Attendance Audit Log 

The ability to track the recording of attendance registers available through the Lesson Attendance 
Audit Log. When the Register button is used to open the Day View window, and the register is 
confirmed (by clicking OK), an entry is made in the Lesson Attendance Audit Log.  This entry will 
include time, date, user initials, form description or teaching set description. 
 

 The Lesson Attendance Audit Log is accessed through the Parameters Window . 

  A double click on this button will activate the Audit Log screen where the user sets the 
criteria required to generate the Audit Log.  

 

 
 

 Clicking on the Specific User radio button activates the drop down list of available users 

 
 

 The Form and Set Selection gives options to choose to report on all teaching sets and 
forms or to choose a specific form or a specific teaching set. 
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 There are two date criteria that may be used in generating the Audit Log. The Attendance 
Date Criteria which refers to the date of the scheduled attendance, and the Entry Criteria 
which refers to the date that the register was actually taken. 

 

  
 

 
 
The Lesson Attendance Audit Log window displays: 

Date of required 
attendance. 

Date the entry was 
made in the log 
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The User name of the person who completed the registration process 
The date and time that the register was taken 
The period and teaching set description for the registered class 
 
The window provides two radio buttons for sorting either by User or by Date/time. Alternatively, 
clicking on a column heading will sort the information accordingly. 
 
The Lesson Attendance Audit Log contains a Purge facility to clear all records that meet the criteria 
entered in the opening Audit window 

 Clicking on the Purge  button will activate the following warning message. The 
information is removed from the data file and stored as a text file in a location of the User’s 
choosing. 

 

 
 

 Clicking on No will abort the procedure, clicking on Yes will generate a second warning 
message. 

 This warning message will inform the user that the process cannot be reversed. Again 
clicking on No will abort the process and Yes will continue the purge process. 

 

 
 

 Clicking on Yes will take the user to the default location within Integris to save the file. 
Cancelling or closing this window will, again abort the purge process. 

 

 Enter an appropriate name for the file and click on Save to complete purging the Lesson 
Attendance Audit Log. 
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8.15 Management Reports 

The Management Reports provides the User with a quick and easy method of checking which 
teaching sets have had their attendance recorded through the registration function. The report can 
be generated for either a single period of the day or a daily summary. An option also exists to 
either hide or show completed registers 
 
The Management Reports is available through the Parameters on the Lesson Attendance Side bar.  
 

 Click on the  button in Lesson Attendance > Parameters to open the 
System Management Reports window.  

 
If the system detects that the TIME module is installed, and that both Timetabled and non-
timetabled Year groups are used, then the Report Type Select screen will appear. 

 

 
 

 If the user selects Teaching Set Registers, then the System Management Reports screen 
will appear: 
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 The window will default to the current date and period based on the system clock and 
timetabling. It will also default to the Single Period radio button and check the Hide 
Completed Registers box. 

 

 If timetabling is not being used or if at the Report Type Select screen the user selects to 
report on Form registration the following window will appear: 

 

 
 
Clicking OK will display both registered and unregistered forms:  
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If timetabling is only being used for attendance set up the following window will be displayed: 
 

 
 

 To generate a Daily Summary Report, set the Attendance Period to the last period of the 
day, select the radio button for daily summary.  The Attendance Period drop down must be 
set to the last period of the day if registers for all timetabled classes for the selected day are 
to be displayed. Next determine whether the report is to display all registers, completed or 
not or just the incomplete registers by either leaving the Hide Completed Registers box 
checked or unchecked. 
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 The window below is shows a System Management Report hiding completed registers: 
 

 
 
The window below is shows a System Management Report displaying all registers: 
 

 
 
The System Management Reports Window contains a Print button to enable a print out of 
information. 
 

Teaching sets flagged 
to show if registered or 
not. 

Completed Registers 
date and time 
stamped 
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Sample of System Management Report showing all registers: 
 

 
Sample of System Management Report showing incomplete registers 
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9 Behaviour Module - Related Functionality  
 
With the Behaviour Module loaded and set up it is possible to denote which lesson attendance 
codes are used to mark student withdrawals and suspensions.  
 

 
 
Once these preferences have been set up the relevant attendance codes will no longer be 
available for use within the following Lesson Attendance windows: 
 
Day View 
Week View 
Student View  
Speed Entry 
Lates 
 

 
 

Codes W and Z 
not available 
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10 Recording Students’ Change of Status 
When a student’s details change in any of the following ways, their status will be updated in 
Lesson Attendance: 

 changing part-time status 

 changing form group 

 changing roll status, or 

 transferring to another roll 
 

10.1 Change Part-Time Status 

When a student’s FTE status (in Administration Manager > Student Details) changes from full-time 

to part-time (either am, pm or custom)  or from part-
time (either am, pm or custom) to full time their new part-time status is passed to the Lesson 
Attendance module.  
 
The user will be warned that if the attendance data is not up to date, at least to the working day 
before the current day, the change to the student’s part-time status will take effect from the last 
date for which daily records have been created. 
 

 
 
The user will then be asked if they wish to back date the change and asked for a date.  
 

 
 

Note: This date must be the same as or earlier than the date up to which records have 
already been created for the student. If the user enters a date in the future a message is 
displayed, warning that the change will take effect from the next date for which ‘Create Daily 
Records’ is run.  

 
 
The user has the options to accept the date (Yes) or cancel the date (No). 
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The date must also be within the current attendance year. If it is not in the current attendance year 
the following warning is displayed. Click OK. 

 
 
The change part-time status function will alter the student’s attendance records to reflect the new 
FTE status for all attendance records on and after the date given.  
 
Example 1 
If a full-time student attends school mornings only from 6 February onwards, their records will 
reflect this in Day View and Week View. A ‘-‘indicates that the student does not attend school in the 
afternoons. 
 

 
 
Example 2 
If a part-time student’s status changes to full-time, the user will be asked for the date from which 
the date is to take effect. 
 

 
 
The changed status will be reflected in Day View and Week View. 
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10.2 Change Form 

When a student changes from one form group to another and their student details are changed in 
Student Edit (Administration Manager Module) to reflect the change, the details are passed to the 
Lesson Attendance module. 
 
The user is warned that if the school’s attendance data is not up to date, i.e. Daily Records have 
not been created at least up to the working day before the current day, the change to the student’s 
Form Group will take effect from the last date for which ‘Create Daily Records’ was run. 
 

 
 
The function will ask the user if they wish to back date the change of Form Group and for a date.  
 

 
 
This date must be the same as or earlier than the date up to which daily records have already been 
created for the student and must also be within the current attendance year.  
The function will alter the student’s attendance records to reflect the new form for all records on 
and after the date shown.  
 

10.2.1 Changing Form through Speed Edit 

 
There may be instances where a student or group of students’ form is changed through the use of 
the Speed Edit function (Admin > Speed Edit). In this instance, the change will not be carried 
through to Lesson Attendance. In order for this change to be reflected accurately the ‘formchange’ 
gateway function must be invoked. The gateway function can only be activated by a user with 
Administrator status. 
 

Note: The Gateway function should only be used within Integris in Single User Mode and 
under the guidance of your Support Officer. 
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To allow the Speed Edit form change to flow through to Lesson Attendance: 

 Activate the Gateway through File > Gateway and enter the gateway command 
 

 
 

 In the Student Form Change Utility window enter the appropriate date range and use the 
New Query button to locate the required student/students and click on OK 

 

 
 

 A warning message will be generated asking “Are you sure that you want to amend these 
records?” Click on Yes to continue or No to abort the function. 

 Continuing with the function will generate the following message. 
 

 
 

 Click Ok on the Information message and Exit the Change window. 
 

10.3 Change Roll Status– Individual Student 

If a student’s roll status is changed in Administration Manager Module > Student Details, the user 
will be asked if they wish to back-date the change and for a date.  
 
Example: a student is being moved from the current roll to the former roll in the Administration 

Module > Student Details > Move Student to Former Roll.   The following message is 
displayed. The current date is displayed as the default. The user can accept or overwrite the date 
and then press OK. 
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This date must be the same as or earlier than the date up to which records have already been 
created for the student and must also be within the current attendance year. The function will alter 
the student’s attendance records to reflect the new roll status for all records on and after the date 
shown.  
 

10.4 Change Roll Status – Group of Students 

When a group of students change roll status via Administration Manager Module > Admin Sidebar 
> Utilities: 

 Admissions Transfer to Current Roll or 

 Current Roll to Former Roll or 

 Delete Student From Current Roll 
the date from which the roll status changes and their new roll status is passed to the Lesson 
Attendance module. 
 
The date must be the same as or earlier than the date for which records have already been 
created for the students and must also be within the current attendance year. 
The function will alter the students’ attendance records to reflect the new status for all records after 
the date shown.  
 
Example: three students are leaving the school.  
Their Student Leave Date has been entered as 5/2/2001 in Speed Edit. Their Leave Date has been 
entered in Utilities > Current Roll to Former Roll. 
 

 
 

 Click OK. You will be asked to confirm the move.  

 Click Yes. Their records are updated and a message is displayed, informing the user of the 
number of records updated.  

 Click OK. 
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10.5 Deleting/Purging a Student’s Records 

Users can delete a student from the current roll and purge a student’s records. Both functions are 
available through Administration Manager > Admin sidebar > Utilities. 
 

  
 
When using either of these functions users will be prompted to delete a student’s attendance data 
before proceeding. 
 

10.5.1 Delete Students Day Records 

The Delete Student Day Records is available from the Lesson Attendance > Parameters. Refer to 
Section 8.8 for details.  
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11 Miscellaneous Functionality 

11.1 Access to Toolbar Functions 

You may access the Lates , the Evacuation Report , the Emergency Student  

and the Emergency Staff  functions while using following windows: 
 

 Day View Section 5.3 

 Week View Section 5.4 

 Absences > Student View Section 6.10 

 Absences > Unresolved Absences Section 6.11 

In these screens, if you use the Lates window to change the Day Record of a student you are 
actually viewing, you will need to click on the "Refresh" button to update the display. 
  
Access to the toolbar has also been granted from: 

 Absences > Absence Follow Up - Main Screen  Section 6.1.4 

 Absences > Absence Tracking - Main Screen Section 6.2.1 

  
In these windows, if you use the Lates screen to change the Day Record of a student you are 
actually viewing, you will not be able to refresh the display without closing the screens and 
reopening them. The same is the case if you open "View Details", and edit the student Day 
Records. 
 
Access to the toolbar has also been granted from the Speed Entry window. Refer Section 5.2.1. 
 

11.2 Multi-User Handling 

There are occasions where users are being advised that other users have changed attendance 
codes. The way these checks function for multi-user handling of the Day View, Week View and 
Student View windows are described below. 
 

 Checks made on changes to attendance codes are based on each individual period code to 
see if it has been changed by another user, and it will only report issues where two users 
have changed the same period. 

 For registration users it makes a decision on which code to use and then advises the user.  
See the rules in the table below. 

 There is also a Refresh button that will reload data.  It is available whenever the Cancel 
button is not available.   

 
 
 
 
 
 

11.2.1 For Registration Users 

(i.e. users who have started the Day View window via the Registration icon) 
Where a period code has been changed by the register taker AND the period code has also been 
changed by another user: 
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Initial Code Changed 
by User to: 

Changed by 
other user 
to: 

Action 

Any Present Absent/L Accept User’s code and advise 

Any Present Present None required – as with any other changes 
where both new codes are the same 

Any Absent/L Present Accept user’s code and advise user 

Any Absent/L Absent/L Where the two new codes differ - Use code with 
higher ranking, or use User’s code if they are of 
same ranking – see below for rankings. Advise 
user. 

 
Ranking 
Attendance codes are ranked in the following order when choosing which one to use. 
Present 
Late 
Approved 
Authorised 
Unauthorised & Resolved 
Unauthorised and not resolved 
 

11.2.2 For Day View Users 

(i.e. those who have entered Day View via the Day View icon) 
 
Where a period code has been changed by the Day View user AND the period code has also been 
changed by another user: 
 

Initial Code Changed 
by User 

Changed 
by other 
user 

Action 

Any Present Absent/L Ask – as in previous version 

Any Present Present None required – as with any other changes where 
both new codes are the same 

Any Absent/L Present Ask – as in previous version 

Any Absent/L Absent/L Ask – as in previous version 
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13 Support  

13.1 WA 

Should you require support please contact the Customer Service Centre (CSC) at the Department 
of Education. 
 
Contact details below: 
 

Phone (CSC) 

Metro:   9264 5555 
Country:  1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 
 

Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 
 

Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 
 

13.2 NT 

Should you require support please contact the following: 

DEET SAMS Support  

Email  sams.deet@nt.gov.au 
Or Call DEET Hotline 8999 3531 
Or Fax SAMS/DEET 89995611 
Or Web Site  http://www.latis.net.au/sams/ 
 

mailto:customer.service.centre@education.wa.edu.au
mailto:sams.deet@nt.gov.au
http://www.latis.net.au/sams/

